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1 What's New in Cube Designer

Links to information about the new features and documentation changes for Cube Designer.

What's New in version 10.1 Support Package 06

What's new Link to more information
From Cube Designer, you can now display your personal Displaying your Personal Information [page 13]
information.

What's New in version 10.1 Support Package 05

What's new Link to more information

For SSAS deployments, you can define eliminations and Hierarchy Selection [page 51]

consolidations with two rollup hierarchies.

What's New in version 10.1 Support Package 02

What's new Link to more information

SAP HANA Deployments: SAP HANA Deployment [page 103]

The modeling views that are now deployed are the following,
just like in version 10 Support Package 16:

e Analytic views (equivalent to calculation views of cube
type in version 10.1)

e Attribute views of dimension type (equivalent to
calculation views of dimension type in version 10.1)

Solution lock: Introduction to Solutions [page 15]

When opening a solution, you can now lock it so that only
you can modify the solution. Any other user can access the
solution in read-only mode.

SAP Financial Consolidation Cube Designer User Guide
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What's New in version 10.1

What's hew Link to more information

SAP HANA Deployments: SAP HANA Deployment [page 103]

e The modeling views that are now deployed
areCalculation views of cube type (equivalent to
analytic views in version 10 Support Package 16)

e (Calculation views of dimension type (equivalent to
attribute views in version 10 Support Package 16)

Since Financial Consolidation 10.0 Support Package 16, itis ® Creating Views [page 22]

possible to deploy SAP BW cubes based on SAP HANA, e Creating an SAP NetWeaver Business Warehouse
from a Financial Consolidation database hosted on a SAP Deployment [page 89]

HANA server. The modeling views that are now deployed

are no longer analytic and attribute views but calculation

views of two types:

To do so, you specify the deployment type in the view. Then,
you enter the SAP HANA server and port that hosts the
Financial Consolidation database.

SAP Financial Consolidation Cube Designer User Guide
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2 Getting Started

2.1 General Overview of Cube Designer

SAP Financial Consolidation, Cube Designer is an application which enables authorized users to map the two

following types of structured data:

e Data storedin a SAP Financial Consolidation database.
e Datato be stored in OLAP cubes and/or star schemas.

. . . . Dimensions

Financial Consolidation Members

Characteristics

Filters

Rollup hierarchies

Data (package, consolidated)

Cube Designer

SSAS Server

) ﬂ Cube 1

\/

< Cube 2

\

Database

SAP NetWeaver BW Server

| Cube3

\ 4

\

/—/J Cube 4

Solution 1
> View 1
Deployment 1
> View 2
Deployment 2
Deployment 3
> View 3
Deployment 4
Solution 2
> View 1

Dimensions
Members
Characteristics
Consolidated data

In the above diagram, the steps are as follows:

Phase 1 - Creating a solution

SAP HANA

Deployment 5

When you create a solution, the SAP Financial Consolidation database security parameters are loaded in the

solution.
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Phase 2 - Creating a view

When you create a view, the following SAP Financial Consolidation database elements are loaded in the
solution: dimensions, members, characteristics and filters.

i Note

When creating a view for SAP HANA deployments, the characteristics and filters are not loaded in the
solution.

Phase 3 - Creating a cube deployment or a star schema deployment

e (reating a cube deployment. When you create a cube deployment, you specify on which server you want to
create the cube.

e C(Creating a star schema deployment. When you create a star schema deployment, you specify on which
database server you want to create the star schema.

Phase 4 - Generating a cube or a star schema

® Deploying and processing a cube.
o When you deploy a cube, the following SAP Financial Consolidation database elements are loaded in
the cube: dimensions, characteristics and rollup hierarchies.
o When you process a cube, the SAP Financial Consolidation database members and data are loaded in
the cube.

i Note

For SAP HANA deployments, we only talk about deploying and deploying consists in loading
dimensions, members and data in the cube.

e Deploying a star schema. When you deploy a star schema, the following tables are created:
o Dimension tables
o Characteristic tables
o Fact table(s) containing data

Users will then be able to view and analyze the data contained in the cubes using retrieval tools.

SAP Financial Consolidation Cube Designer User Guide
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2.2 Connecting to Cube Designer
Procedure

1. Select|p Start » Programs » SAP BusinessObjects ¥ Financial Consolidation » Cube Designer 3.

The logon dialog box opens.

2. Perform one of the two actions below:

o If the single sign-on (SSO) has been activated: the SAP BusinessObjects Enterprise Credentials area is
already filled in. Select the connection you want to use from the EPM Connection drop-down list.

i Note

For more information on how to activate the SSO, see the SAP Financial Consolidation Security
Guide.

o If the single sign-on (SSO) has not been activated: in the SAP BusinessObjects Enterprise Credentials
area, enter or select the information you use to connect to the Central Management Console of your
SAP BusinessObjects Enterprise platform and select the connection you want to use from the EPM
Connection drop-down list.

i Note

The Authentication Status area gives you a clear status on whether the credentials are correct or not.

3. Click the OK button.

Cube designer opens. The name of the connection appears below the window title bar.

2.3 Main Steps

When working with cube designer, you must deal with the following:

e Solutions

o \iews

e SSAS cube deployment

e Star schema deployment

e SAP NetWeaver Business Warehouse (SAP NetWeaver BW) cube deployment

Related Information

Introduction to Solutions [page 15]
Introduction to views [page 20]
Introduction to Cube Deployments [page 72]

SAP Financial Consolidation Cube Designer User Guide
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Introduction to Star Schemas [page 108]

2.4 Cube Designer Functional Rights

To be able to use cube designer, you must have the following rights:

e Design cube right. This right is managed in the Central Management Console for the EPM connection
manager.
e Analytics administration right. This right is managed in SAP Financial Consolidation.

To find out more about rights, refer to the SAP Financial Consolidation Security Guide.

2.5 Overview of Reporting in SAP HANA

Cube designer allows to create SAP HANA modeling views, based on the Financial Consolidation database.

Financial Consolidation data and metadata can then be viewed and analyzed in real-time in the supported
retrieval tools.

One Consolidation Table

The consolidated data of the various consolidation tables of Financial Consolidation are integrated into one
unique consolidation table, also called a fact table. This way, it is possible to easily retrieve several
consolidations in a unique report. To generate or update this fact table, you need to run a stored procedure. To
find out more about the stored procedure, see the SAP Financial Consolidation Administration guide.

SAP Financial Consolidation Cube Designer User Guide
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Financial Cnnsoli®
K Database//

Consolidated Table

Consolidated Table

Consolidated Table Fact Table

\

Consolidated Table

Consolidated Table

>

Stored Procedurs

SAP HANA Modeling Views and Security Objects

Performing a SAP HANA deployment using Cube Designer consists of creating the following SAP HANA
modeling views:

e Ananalytic view. The analytic view is defined on the fact table containing Financial Consolidation data
along with the created attribute views.
e Attribute views. One attribute view is created per dimension included in the cube designer view.

Also, the following security objects are deployed:

® Roles. A SAP HANA role is created for each Financial Consolidation data access group; and a unique role is
created that gives access to all the data and is assigned by default to the SAP HANA user.

e Privileges. A SAP HANA privilege is created for each dimension and each cube that has been deployed.

e Stored procedures. A SAP HANA stored procedure is created for each filter and characteristic defined on a
Financial Consolidation data access group.

For more information on SAP HANA deployments, see SAP HANA Deployments [page 103].

SAP Financial Consolidation Cube Designer User Guide
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Real-Time Update and Automatic Refresh in SAP HANA

Once a first SAP HANA deployment has been performed, thanks to the real-time update mechanism, the
following items are automatically updated in the SAP HANA modeling views as soon as they are updated in
Financial Consolidation:

e Master data, that is members and hierarchies.
e Security objects, that is roles, privileges and stored procedures.

SAP HANA

— T -
A

—Master Data (members, hierarchies)—s

Financial OLAP
Consolidation Engine
Database Security ———— >

~—

However, when metadata - that is dimensions and characteristics - is updated in Financial Consolidation and if
you want to include them in the cube designer view and consequently in the analytic view, then you need to
perform a redeployment so that the modeling views are updated as well.

Data refresh: when consolidated data has been modified in Financial Consolidation, you can update the fact
table by executing the dedicated stored procedure. This stored procedure can be triggered manually or you can
also create pre-consolidated tasks that can be scheduled periodically. To find out more about the stored
procedure, see the SAP Financial Consolidation Administration guide

Related Information

SAP HANA Deployments [page 103]

2.6 Displaying your Personal Information

Context

If you want to display your personal information stored within the application (in the SAP Financial
Consolidation database), follow the procedure below:

SAP Financial Consolidation Cube Designer User Guide
Getting Started PUBLIC 13



Procedure

Click | Tools ¥ Personal information 3.

The Personal Information dialog box displays all information related to the user you are connected with. It
displays information such as the code, the short and long description of the user, and his/her email address.

SAP Financial Consolidation Cube Designer User Guide

14 PUBLIC Getting Started



3 Solutions

3.1 Introduction to Solutions

A solution contains one or more views and a view contains one or more deployments.
A solution is stored in the SAP Financial Consolidation database.
A solution is connected to one SAP Financial Consolidation data source only.
When you open a solution, you can choose to lock it to make sure that only your modifications are taken into
account. While you lock the solution, any other user can access the solution in read-only mode.
i Note

® You open a solution without locking it, then enter modifications and want to save your modifications.
Meanwhile, another user has opened and locked the solution. In such a case, you cannot save your
modifications unless you ask the other user to unlock the solution. Alternatively, you can rename the
solution and save your modifications.

e \When a solution is locked, you can still copy it and export it. However, you cannot import it using the
same name.

3.2 Creating Solutions
Procedure

1. Incube designer main window, select [+ File » New Solution 3.

The New Solution dialog box opens.

2. Inthe Name field, enter the name you want to give the solution.

i Note

For SAP HANA deployments, here is the list of characters you can use for the solution name: a to zin
lower or upper case, O to 9, the characters - (hyphen) and_ (underscore). The space character is not
supported.

3. Inthe Description field, enter a brief description explaining the solution. The description is optional.

4. Click the OK button.
The new solution opens.

SAP Financial Consolidation Cube Designer User Guide
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3.3 Opening Solutions

Procedure

1. Incube designer main window, select [ File » Open Solution 3.

The Open Solution dialog box opens.
2. Select the solution you want to open.

3. a. Ifthe solution is not already locked by another user and you want to lock it, click the checkbox in the

Locked column. The other users can open the solution in read-only mode.
b. If the solution is locked by another user, you can open the solution in read-only mode.

i Note

When selecting a solution in the left part of the main cube designer main window, you can view the
status of the solution (locked or not) in the upper part of the main window and in the General tab. You
can also view the name of the user who has locked the solution in the General tab.

4. Click the Open button.

The solution opens.

3.4 Renaming Solutions
Procedure

1. Inthe left part of the main window, right-click on the name of the solution you want to rename, then select
Rename.

2. Enter the name you want.

3.5 Delete Solutions

You can delete one or several existing solutions.

Before they are deleted, you can save the solutions in external XML files, so that you will be able to re-import
them later.

SAP Financial Consolidation Cube Designer User Guide
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3.5.1 Deleting Solutions
Procedure

1. Select|p File » Delete Solutions 3.
The Delete Solutions dialog box appears.

2. Select the checkbox(es) for the solution(s) you want to delete.
->Tip
You can select all the solutions at the same time by clicking the Select all button.
You can save the solution(s) you delete in an XML file by selecting the Archive deleted solutions to

external XML option. This way, you will be able to re-import the solutions later if needed.

3. Click the Delete button.
A confirmation message appears.

4. Click the OK button.

i Note

If you have selected the Archive deleted solutions to external XML option, a dialog box opens where you
can choose the filename(s) and location(s) of where you want to save the deleted solution(s).

3.6 Language Selection

There are two types of language:

e |[nterface language. The interface language is the language used for menus, commands, buttons, etc, that
make up the interface.
e Datalanguage. The data language is the language in which all of the translatable text and descriptions
appear.
You can change both languages at any time using the Data Language drop-down menu located in the upper
part of the window and the Interface Language drop-down menu available by selecting |# Tools » Options »
Display 3 tab.

3.7 Solution Export and Import

If you want to create a solution based on an existing one, and modify some other information, you can do the
following, using the solution import and export functions:

e Export the solution.

SAP Financial Consolidation Cube Designer User Guide
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e Edit the exported solution and modify it so that you have a new solution.
® |mport the new solution.

The import and export files are in .xml format.

i Note

You can also import or export solutions without using cube designer interface.

i Note

You can also execute the Cartesis.InformationDelivery.SolutionExporter.exe or
Cartesis.InformationDelivery.Solutionimporter.exe files that are located in the cube designer directory.

Related Information

Solution Export [page 123]
Solution Import [page 124]

3.7.1 Exporting Solutions
Procedure

1. Select|p File » Export Solution .
The Export Solutions dialog box opens.

2. Inthe Solutions to export groupbox, select which solutions you want to migrate.
- Tip
You can use the Select All or Select None buttons.

3. Inthe Export Location groupbox, select the target folder and enter the name for the XML file.

4. Click on Export.

3.7.2 Importing Solutions
Procedure

1. Select | File » Import Solution 4.
The Import Solutions dialog box opens.

2. Inthe Import File groupbox, select the XML file containing the solutions you want to import.

SAP Financial Consolidation Cube Designer User Guide
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3. If you want to overwrite solutions with the same name, check the Overwrite Existing Solutions box.

4. Click onImport.

SAP Financial Consolidation Cube Designer User Guide
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4 Views

4.1 Introduction to views

You will first create a view for a specific solution.

Once the view is created, and depending on the type of deployment, you will carry out the following operations:

e Choosing the languages.

e Selecting and defining measures.
® \iewing scopes.

® Defining dimensions.

SAP HANA Deployments

For SAP HANA deployments, once the view is created , you will carry out the following operations:

e Choosing one language.

e Defining standard dimensions. Standard dimensions include analysis dimensions.

Related Information

View Creation [page 20]

Language Selection [page 23]

Measure Selection and Definition [page 23]
Scopes [page 29]

Merged Dimension Definition [page 30]
Standard Dimensions [page 38]

4.2 View Creation

Creating a view consists of the following main steps:

e Selecting the type of data from the SAP Financial Consolidation database: Package or Consolidated.

| Restriction

For SAP HANA deployments, Package data is not taken into account. Consolidated data only is taken

into account.

20 PUBLIC
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Retrieving the standard dimensions from the SAP Financial Consolidation database.
The dimensions available depend on the data level you choose.

o For the package data level, the following dimensions are available: Account, Reporting Unit, Original
Reporting Unit, Data Entry Period, Period, Category, Flow, Audit ID, Currency, Share, Partner and
custom dimensions which are indicated by a blue cube.

o Forthe consolidated data level, all the package dimensions plus the following dimensions are available:
Scope, Consolidation currency, Elimination and Variant.

i Note

The Elimination dimension is excluded by default. When you select an origin unit or a reporting unit
rollup hierarchy, the Elimination dimension is automatically included in Financial Consolidation
Cube Designer because it is required to view eliminations at Divisional Level. To view eliminations
at group level only, you do not need the Elimination dimension, you can simply use the different
audit IDs. The Elimination dimension has the five following members:

o

(¢}

o

i Note

Reported: Consolidated amount without any elimination.

Eliminated at Group Level : Eliminations done at the level of the group.

Consolidated at Group Level: Reported + Eliminated at Group Level.

Eliminated at Divisional Level. Eliminations done according to the reporting unit rollup
hierarchies are eliminations by level. This requires an origin unit or a reporting unit rollup
hierarchy in the cube in order to work. For each node, an Elimination leaf is automatically
created in the rollup hierarchy to display the amounts that have been eliminated at divisional
level.

Consolidated at Divisional Level: Reported + Eliminated at Divisional Level.

Consolidated with 2 rollup hierarchies at Divisional level. When you select two rollup
hierarchies, this member and the member below are automatically added to the Elimination

dimension to display the amounts that are specific to this consolidation based on two rollups.

Eliminated with 2 rollup hierarchies at Divisional level.

For SAP HANA deployments, the Elimination dimension is not taken into account.

4.2.1 Scope Hierarchies Historization

If you are working with consolidated data, you can historize the scope hierarchies for the Reporting Unit
dimension. This way, you will:

Keep track of changes in scopes.

Keep consolidated data and not recalculate them in the cube over time.

Conso 12 2005 Conso 12.2006 Conso 12.2005 Conso 12 2006
Division 1 74 Division 1 43 Division 1 74 43
BU1 18 BU1 15 BU1 18 15
BU2 9 BuUz2 6 Bu2 9 6
BU3 25 BU3 22 BU3 25 22
: 2 — z
Division 2 55 Division 2 63 Division 2 55 63
BU4 18 BU4 12 BU4 18 12
BUS 37 BUS 33 BUS 37 33

U 18 BUG
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Reporting unit scope hierarchies - and only these - will be merged into a single hierarchy.

If you choose to historize the scope hierarchies, once you have selected the members for the merged hierarchy,
you will be able to choose the order in which the hierarchies will be taken into account.

You should note the following:

e |nthe General tab of the view, the Using Historized Scopes option is checked by default and cannot be
unchecked.

e The Historization tab (included in the Members tab) is available for the Consolidations merged dimension
and will enable you to choose the order in which the hierarchies will be taken into account.

® |nthe Reporting Unit dimension, the Historized scope hierarchy is selected as a Parent child hierarchy and
cannot be modified.

e The Live Access tab for the Reporting Unit dimension is disabled.

! Restriction
This feature does not apply to SAP HANA deployments.

4.2.2 Creating Views

Procedure

1. Inthe main window, right-click on the Solution name, then select Add View.
The New View dialog box opens.

2. Inthe View groupbox, enter the following information:

a. Inthe Name field, enter the name you want for the view.

i Note

For SAP HANA deployments, here is the list of characters you can use for the view name: a to z in
lower or upper case, O to 9, the characters - (hyphen) and_ (underscore). The space character is
not supported.

b. Inthe Description field, enter a brief description explaining the view. The description is optional.

3. Ifthe Financial Consolidation database is hosted on a SAP HANA server, the Deployment Type area is
displayed. Depending on the type of deployment you want to perform afterwards, you can select SAP
HANA or SAP BW.

4. Inthe Data Level groupbox, select one of the following options, depending on what type of data you want:

o Package.
o Consolidated. This option is selected by default.

A\ Caution

The choice you make here is definitive. Once you have clicked on the OK button, you will no longer
be able to change the data level.

SAP Financial Consolidation Cube Designer User Guide
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| Restriction

For SAP HANA deployments, Package data is not taken into account. Consolidation data only is
taken into account.

5. Click the OK button.
The view appears below the solution with its dimensions.

4.3 Language Selection
You can choose the data languages you want to make available in the future cube, i.e. the languages in which all

of the translatable text and descriptions will appear.

When defining an SSAS cube, you will have to choose the default language from all the languages which have
been selected for this view.

| Restriction

One language only is supported for SAP HANA deployments.

Related Information

SSAS Deployment and Cube Information [page 74]

4.3.1 Choosing the languages for the cube

Procedure

1. Select the appropriate view.

2. Inthe Languages groupbox of the General tab, select the languages you require.

| Restriction

One language only is supported for SAP HANA deployments.

4.4 Measure Selection and Definition

A measure is an SSAS dimension that you can customize.

SAP Financial Consolidation Cube Designer User Guide
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The available amounts for the measure dimension depend on the data level selected when creating the view.

e |f the Package data level has been selected, the Local amount will be available.

e [fthe Consolidation data level has been selected, the Local, Converted and Consolidated amounts will be
available.

| Restriction

For SAP HANA deployments, Package data is not taken into account. Consolidation data only is taken
into account.

4.4.1 Multi- or Single Measure Modes

Depending on how you want the data to be retrieved in the data retrieval tools, you can choose one of the
following measure modes:

e multi-measures.

| Restriction

This mode is not supported for SAP NetWeaver Business Warehouse (SAP NetWeaver BW)
deployments. If you choose this mode, in the SAP NetWeaver BW deployment part, an issue to resolve
will be indicated and you will have to choose the single measure mode in order to deploy the cube.

| Restriction

This mode is not supported for SAP HANA deployments.

® single measure. This is the default mode.

As opposed to the multi-measure mode, the single measure mode enables you to view all detailed and non
detailed data on the same measure.

Related Information

Multi-measures Behavior [page 24]

Single Measure Behavior [page 27]

4.4.2 Multi-measures Behavior

Once you have chosen the data amount(s) you want, you can further detail the measures by including
dimensional analyses. The dimensional analyses proposed contain the detailed dimensions used in the SAP
Financial Consolidation analysis hierarchies for the category selected.

You can select the dimensional analyses you want and you can also create new ones.
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i Note

If no dimensional analysis appears, this means that no member of the Category dimension has been
selected.

Each dimensional analysis you select will be available for selection in the General tab of the view.
Each dimensional analysis selected will become a measure in the future cube.

The name of a measure will appear as follows in the cube : [type of amount] - [dimensional analysis].

Example

In the Dimensional Analysis tab, the "Partner" dimensional analysis is selected.

In the General tab of the view, the available measures are as follows:

Measures

— Consolidated Amount

— Converted Amount

— Local Amount

— Consolidated Amount Partner

— Converted Amount Partner

L Local Amount Partner

Example

The following example will show you how the detailed measures will appear in a cube.
In cube designer, the following elements are selected:

e Data level selected: Consolidation
e Amounts selected for the Measure dimension: Local and Consolidated
e Dimensional analysis selected: Partner/Product and Activity

In the future cube, the Measure dimension will be detailed as follows:
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Measures

— Consolidated Amount

— Consolidated Amount Partner/Product
— Consolidated Amount Activity

— Local Amount

—  Local Amount Partner/Product

— Local Amount Activity

The Consolidation and the Local members are non-detailed amounts.

4421 Activating the Multi-measures Mode

Prerequisites

This mode is not supported for SAP NetWeaver Business Warehouse (SAP NetWeaver BW) deployments. If you
choose this mode, in the SAP NetWeaver BW deployment part, an issue to resolve will be indicated and you will
have to choose the single measure mode in order to deploy the cube.

Procedure

1. Select|p Tools » Options 3.
The Options dialog box opens.

2. Inthe General, tab select the Multi Measure Group Analysis.
3. Click OK.

4422 Selecting a Dimensional Analysis

Procedure

1. Select the view.
2. Select the Dimensional Analysis tab.

3. Select the dimensional analysis you want.
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4423 Creating a Dimensional Analysis

Procedure

1. Select the view.
2. Select the Dimensional Analysis tab.

3. Under Custom Measure Groups, double-click on <Double-Click here to add a new Custom Measure Group>.
The Custom Dimensional Analyses dialog box appears.

4. Enter a name for the analysis.

5. Select all the dimensions you want.
->Tip
Use the Ctrl keyboard button to select more than one dimension.

6. Click the OK button.
The new analysis appears in the list under Custom Measure Groups and is selected by default.

44.24 Selecting Data Amounts for the Measure Dimension

Procedure

1. Select the view.

2. Inthe Measures groupbox of the General tab, select the data amounts you want.

4.4.3 Single Measure Behavior

The dimensional analyses are automatically selected if the analysis dimensions are included in the cube.

i Note

To include a dimension in the cube, right-click on the dimension in the tree structure part of the window and
select Include.

As a general rule, the data for a single measure will appear on the detailed hierarchies as follows:
All detailed <name of the analysis dimension>
—  Member 1

—  Member 2 Detail
— Member 3

— No detail = Not detailed
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The amount on the node is the result of the sum of the detail: that is, members 1, 2 and 3. The "No detail"
amount is not part of the sum.

The default name for the node is: 211 detailed <name of the analysis dimension>.You canrename
the node.

i Note

To rename this node, click the Translation tab and enter the text you want in each language available. For
SAP HANA deployments, the Translation tab is not available.

A\ Caution

It is highly recommended that you set the default member to "No detail". Otherwise, you will always see the
analyzed data in the reports.

| Restriction

For SAP NetWeaver Business Warehouse deployments, the "All detailed" member includes not only all
detailed child members but also the "No detail" member (that is the "NA" member).

| Restriction

For SAP HANA deployments, Local Amount, Converted Amount and Consolidated Amount are
automatically selected and cannot be changed.

Example

In the Dimensional Analysis tab, the "Partner" dimensional analysis is selected.

In the General tab of the view, the available measures are as follows:

Measures
Local Amount

Converted Amount
Consolidated Amount

Each dimensional analysis will be aggregated in the Local, Converted and Consolidated amounts.

Example

The following example will show you how the detailed measures will appear in a cube.

In cube designer, the following elements are selected:

e Data level selected: Consolidation

SAP Financial Consolidation Cube Designer User Guide
28 PUBLIC Views



e Amounts selected for the Measure dimension: Local and Consolidated
e Dimensional analysis selected: Partner/Product and Activity

In the future cube, the Measure dimension will be detailed as follows:

Measures
Consolidated Amount

Local Amount

Related Information

Selecting a Default Member for a Hierarchy [page 63]

4.4.31 Selecting the Data Amounts (for the Measure
dimension) and a Dimensional Analysis

Context

| Restriction

For SAP HANA deployments, Local Amount, Converted Amount and Consolidated Amount are
automatically selected and cannot be changed.

Procedure

1. Select the view.

2. Inthe Measures groupbox of the General tab, select the data amounts you want.

4.5 Scopes

If you have chosen to work with consolidated data, the Scopes tab appears.
The scopes displayed in the tab are related to the members selected in the Scope dimension.

The tab enables you to view the scope hierarchies.

| Restriction

This feature is not supported for SAP HANA deployments.
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Related Information

Hierarchy Selection [page 51]

4.5.1 Viewing a scope hierarchy

Procedure

1. Inthe tree structure part of the window, select the appropriate view.
2. Select the Scopes tab.

3. Inthe Scopes section, select the scope you want to view.
In the Scope Hierarchy section, the hierarchy appears.
->Tip

You can use the Show All button to display all the levels of the hierarchy.

46 Merged Dimension Definition

Defining merged dimensions consists of the following steps:

e Merging dimensions

e (Changing and translating the name of a merged dimension
e Naming and selecting the members of a merged dimension
e QOrdering scope hierarchies

| Restriction

For SAP HANA deployments, you cannot merge dimensions.

Related Information

Merged dimensions [page 31]

Name Change and Translation for Merged Dimensions [page 33]
Member Name and Selection for a Merged Dimension [page 34]
Scope Hierarchies Order [page 37]
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4.6.1 Merged dimensions

46.11 Pre-defined Merges

Depending on the data level you have chosen when creating the view, you can merge the following dimension
combination: Conso Definitions, Reporting ID or Consolidations.

e For the package data level, the following dimensions are available: the Category and Data Entry Period
contained in the Reporting ID.

e For the consolidated data level, all the package dimensions plus the following dimensions are available:
Scope, Consolidation currency and Variant contained in Conso Definition; Category, Data Entry Period,
Scope, Consolidation currency and Variant contained in Consolidations.

46.111 Merging a Pre-defined Combination of
Dimensions

Procedure

1. Inthe tree structure part of the window, right-click the Merged Dimensions node and select one of the
following: Merge 'Conso Definitions', Merge 'Reporting ID' or Merge 'Consolidations’.

Some of them may not be available. Two reasons are possible:

o The merge has already been defined and appears in the Merged Dimensions node.
o  The merge cannot be performed because of the data level you have already chosen when creating the
view.

i Note

By default, none of the members are selected.

2. You will then select the members that will appear in the cube.

- Tip

To rename the newly merged dimension, right-click on it and select Rename.

Related Information

Selecting the Members of a Merged Dimension [page 36]
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46.1.2 Customized Merges

You can merge other dimensions of your choice. You can then rename the resulting merged dimension
members.

Merging dimensions can result in a high volume of metadata.

On alarge set of members, this behavior can lead to a cumbersome selection process. This is why you can
select the members to be merged, therefore producing a smaller set of combinations.

Example: For instance, merging the following dimensions:

e Products:P1, P2
e Geography: France, UK
e Activity: Ab, A6

would generate the following combinations: P1 France A5, P1 France A6, P1 UK A5, P1 UK A6, P2 France A5, P2
France A6, P2 UK A5, P2 UK A6.

46.1.21 Merging the Dimensions of your Choice

Procedure

1. Inthe tree structure part of the window, right-click the Merged Dimensions node and select Add Custom
merge.

The Create New Merge Definition dialog box appears.

2. Inthe Available Dimensions area, select one of the dimensions you want to merge and click the IB button.
3. Thedimension you have selected appears in the Included Dimensions area.

4. Repeat actions 2 and 3 for each dimension.

i Note

Each time you insert a dimension in the Included Dimensions area, the Estimated Member Count is
updated. It indicates the estimated number of members that will be retrieved in the future cube if you
select all members of each dimension.

5. Click the OK button.

The merged dimension appears under the Merged Dimensions node. By default, the dimension name is the
concatenated names of the dimensions you have merged.

For example, if you have merged the Account and the Flow dimensions, the merge will be named
AccountFlow.
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i Note

By default, none of the members are selected.

6. To select the members that will appear in the cube.
> Tip

To rename the newly merged dimension, right-click on it and select Rename.

Related Information

Selecting the Members of a Merged Dimension [page 36]

4.6.2 Name Change and Translation for Merged Dimensions

You can change the name of the dimension as it will appear in the future deployment.

You can also translate the name of the dimension.

4.6.2.1 Changing and Translating the Name of a Merged
Dimension

Context

The name of the merged dimension appears - in the data language displayed - in the Dimension Identity
groupbox of the General tab. You can change it.

Procedure

1. Click the Translation & Member Names tab.

2. Enter the text for each language.

Results

You can also rename a merged dimension in the current language by right-clicking on it in the left part of the
window and selecting Rename in the context menu.
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4.6.3 Member Name and Selection for a Merged Dimension

While creating the view, you may have chosen merged dimensions. For each merged dimension, you will now:

® (Choose how the name of the members should appear in the future deployment (in the Translation and
Member Names tab).

e Choose the dimension members you want to take into account for each dimension composing the merged
dimension (this is a pre-selection), then for the merged dimension itself (in the Members tab).

i Note

By default, none of the members are selected.

A member name can appear in four ways:

e Code naming. This is the default naming type of a member. A concatenated name is created by grouping
together the codes of the members (from the SAP Financial Consolidation database) contained in the
merged dimension.

e Financial Consolidation naming. This is available for selection for the 'Reporting ID' and 'Consolidations'
merged dimensions. In this case, the members will appear with the same description as in the SAP
Financial Consolidation database (in SAP Financial Consolidation: Category + Data entry period =
Category scenario).

e Deployment Names. A concatenated name is created by grouping together the deployment names of the
dimensions composing the merged dimension.
! Restriction

For SAP NetWeaver BW deployments, depending on the deployment names that have been selected
for each dimension, merged dimension member names cannot exceed 60 characters for SAP
NetWeaver BW. In this case, an issue to resolve will occur and you will have to modify the selection of
the deployment name for the dimensions composing the merged dimension.

e Manual Naming. In this case, you will enter the name you want for the member in each language available.

- Tip

You can also copy and paste the cells from cube designer to Microsoft Office Excel or from Microsoft Office
Excel to cube designer, using the copy and paste buttons in the Translation and Member Names tab.

You can define the default member that will be displayed in the retrieval tool connected to the future cube. This
can be done in the Default Member field of the General tab.

| Restriction

The default member will not be taken into account for an SAP NetWeaver BW deployment.

You can also specify that you do not want the name of the dimension to appear in the retrieval tool by selecting
the Hide dimension name option. In this case, only the selected hierarchy name will appear.

| Restriction

The Hide dimension name function will not be taken into account for an SAP NetWeaver BW deployment.
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i Note

By default, 5 000 members can be displayed for a merged dimension. You can change this number in the

Merge Member Max Display field by selecting | Tools  Options ¥ Display 3 tab.

You can select the members in the Selection tab. You can access this tab by selecting |l [View] » Merged

dimensions » [merged dimension] » Members » Selection 3.
The Selection tab includes:

o The Member Display Filter groupbox.
The following elements can be used to limit which members are displayed:

o Todisplay members containing the same text, enter the text in the Search for members containing
field. Next, open the Match against column drop-down menu and select the column in which the
entered text should appear. Finally, click the Apply button.

- Tip

If you want the search to be case sensitive, select the Filtering is case sensitive option.

o Todisplay only the members you have selected in the Elements groupbox, select the Display selected
members only option.

o You can sort a column in ascending or descending order. This can be done by selecting the column
name from the Sort column drop-down menu.

® The Members groupbox. This part displays the members, depending on the filtering applied. This is where
you select the members you want to take into account.

e The Select all members box. This option enables you to select all the members belonging to the dimension,
and not just the members that are displayed in the Members groupbox. By default, any member added to
the SAP Financial Consolidation structure is retrieved in cube designer. However, these new members are
not automatically selected in cube designer, which means that they do not factor into the existing cube
definition. To avoid having to manually select these new members, click the Select all members option. This
way, the members will be added to the cube in the next deployment.

Related Information

Custom Filtering [page 47]

46.3.1 Naming the Members of a Merged Dimension

Procedure

1. Select the appropriate merged dimension.

2. Select the Translation and Member Names tab.
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3. To

->Tip
You can customize the list of members by ordering them: in ascending or descending order, and based

on their codes or description language. To do so, use the Sort on drop-down list and the Ascending or
Descending buttons.

order the members, Choose how to order the members:

4. Using one of the following buttons, select the naming type you want:

e}

o

Code naming.
Financial Consolidation naming.

i Note

This is available for selection for the 'Reporting ID' and 'Consolidations' merged dimensions.

Deployment Names.
Manual naming.

If you choose this option, enter the names you want for the members in each available language.

- Tip

You can also copy and paste the cells from cube designer to Microsoft Office Excel or from Microsoft
Office Excel to cube designer, using the copy and paste buttons.

The member names appear in the Members groupbox of the Members tab.

46.3.2 Selecting the Members of a Merged Dimension

Procedure

A owop o

36

Open the node for the appropriate merged dimension.
Select one of the dimensions belonging to the merge.
Select the Members tab.

Select the Selection tab.

i Note

By default, none of the members are selected.

In the Members groupbox, check the boxes corresponding to the members you want to take into account.

->Tip

Following are some tips for selecting members:

(¢]

(e}

o

PUBLIC

To select all the members displayed, click the Select Visible button.
To deselect all the members displayed, click the Deselect Visible button.

To select the deselected members and deselect the selected ones, click the Invert Selection
button.
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o Toreset the selection to its default setting, click the Reset button.

o To select all the members (not just the ones that are displayed but all the members belonging to
the dimension, in particular the newly added members in SAP Financial Consolidation), check the
Select all members box.

- Tip

You can use filtering criteria to limit which members are displayed. To find out more about
filtering, see above.

6. Repeat action 2 to 5 for each dimension belonging to the merge.
In the tree structure part of the window, select the merged dimension.
8. Select the Members tab.
i Note

If the Members area is empty, it means that no member has been selected in any dimension.

All the members that appear are a result of the members you have selected for each dimension.

9. Select the members you want to be taken into account in the cube.

4.6.3.3 Scope Hierarchies Order

If you chose to historize the scope hierarchies when creating the view, the Historization tab is also available
next to the Selection tab.

The Historization tab includes:

e The Scope Hierarchy Deployment Order groupbox. This groupbox displays the members selected in the
Members groupbox of the current tab or of the Selection tab. The buttons available will enable you to
choose the order in which the hierarchies will be taken into account.

e The Members groupbox. This groupbox displays the members of the merged dimension. You can select the
members you want to take into account using this groupbox or in the Selection tab.

i Note

The consolidations without scope hierarchies are not displayed.

4.6.3.3.1 Ordering Scope Hierarchies for the
Consolidations Merged Dimension

Procedure

1. Select the Consolidations merged dimension.
2. Select the Members tab.
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3. Select the Historization tab.
4. If you have not already chosen the members in the Selection tab, you can do so in the current tab by
checking the ones you want to take into account.

5. Use the different buttons on the right side to order the members as you like.

4.7 Standard Dimensions

Defining standard dimensions consists of the following steps:

e Changing and translating the names of standard dimensions

® Naming the members of standard dimensions

e Defining the start and end date for periods

e Naming the members of the Period and Data Entry Period dimensions
e Selecting the members of standard dimensions

e Selecting hierarchies

e Selecting attributes

® FExcluding standard dimensions

e Hiding excluded dimensions

e Synchronizing the database and cube structure

SAP HANA Deployments

For SAP HANA deployments, defining standard dimensions consists of the following steps:

e (Changing the names of standard dimensions

e Naming the members of standard dimensions

e Defining the start and end date for periods

e Selecting the members of standard excluded dimensions
e Selecting hierarchies

e Selecting attributes

e FExcluding standard dimensions

Related Information

Name Change and Translation for Standard Dimensions [page 40]
Member Name for Standard Dimensions [page 41]

Start and End Date Definition for Periods [page 44]

Member Name for the Period and Data Entry Period Dimensions [page 45]
Member Selection for Standard Dimensions [page 46]

Hierarchy Selection [page 51]
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Attribute Selection [page 65]

Standard Dimensions Exclusion [page 66]

Hide Excluded Dimensions [page 67]

Database and Cube Structure Synchronization [page 68]

4.7.1 Reporting Category Dimension Creation

The Reporting Category dimension (merges the Data Entry Period dimension and the Category dimension) is
not available by default. You can create it.

You will then be able to create its members, choosing one category and one or several data entry periods.

| Restriction

This feature is not supported for SAP HANA deployments.

4711 Creating the Reporting Category Dimension and its
Members

Procedure

1. Inthe General tab of the view, select the Using Reporting Categories check box.
The Reporting Category dimension is added to the dimensions' list in the tree structure part of the window.

2. Select the Reporting Category dimension.
3. Select the Members tab.

4. To create a member for the dimension, click the Create button.
The Reporting Category dialog box appears.

In the Code field, enter a code for the member you are creating.
In the Long Description field, enter a name for the dimension.

Select a category from the Category drop-down menu.

© N o O

Select the checkboxes of the data entry periods you want to include.

- Tip

You can also use the Filter field and click on Update list to select the data entry periods you want. For
example, if you want to select all occurrences of the month of June , you can enter: *. 06. If you want to
select all the data entry periods, you can enter * . *, The characters you can use to facilitate your
selection are the same as for the Custom filtering section.

9. Click on OK.
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Related Information

Custom Filtering [page 47]

4.7.2 Name Change and Translation for Standard Dimensions

You choose a type of name for all the standard dimensions as they will appear in the future deployment: [code],
[short description], [long description], [extra-long description], [code] - [short description], [code] - [long
description], [code] - [extra-long description], [short description] - [code], [long description] - [code], [extra-
long description] [code], or a custom name.

The name chosen will be applied by default to each dimension.

You can then change the name of each dimension as it will appear in the future deployment.

4.72.1 Choosing a Name for all the Standard Dimensions

Procedure

1. Inthe tree structure part of the window, select Dimensions.
2. Select the General tab.

3. Select the naming type you want from the Dimension default format drop-down menu.

4.72.2 Changing the Name of one Standard Dimension

Procedure

1. Inthe tree structure part of the window, select the appropriate dimension.
2. Select the General tab.

3. The Naming Format drop-down menu displays Use default format, which represents the default name
chosen for all the standard dimensions.

4. If you want to change it, select the naming type you want from the Naming Format drop-down menu.

5. If you have selected Custom Name, the Display Name field is activated and you can enter text of your
choosing for the current dimension.

i Note

You can also enter text of your choosing in each available language in the Translation tab.
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| Restriction

You cannot enter texts in the Translation tab for SAP HANA deployments.

4.7.3 Member Name for Standard Dimensions

While creating the view, you may have chosen standard dimensions. For each dimension, you will now choose
how the name of the members should appear in the future deployment.

You choose a type of name for all the members of all the dimensions as they will appear in the future
deployment: [code], [short description], [long description], [extra-long description], [code] - [short
description], [code] - [long description], [code] - [extra-long description], [short description] - [code], [long
description] - [code], [extra-long description] [code].

The name chosen will be applied by default to each dimension.

You can then add a prefix and/or a suffix to the default name of the members for each dimension and for each
language as they will appear in the future cube.

| Restriction

Prefixes and suffixes are not taken into account for a NetWeaver BW deployment.

| Restriction

Prefixes and suffixes are not supported for SAP HANA deployments.

If there are duplicate members, a pop-up message will appear when you deploy the cube, indicating the
remaining duplicate members and asking you whether you want to continue or to stop deployment.

You can also define other naming types for all the members of all dimensions. Each standard dimension will
inherit the chosen naming type. In addition to that, you can define other naming types for all members of each
dimension.

In your data retrieval tool, the user will be able to choose the naming type to be displayed.

i Note

The retrieval tool must be able to read several descriptions to make this functionality effective.

! Restriction
Member name formats deployed in SAP NetWeaver BW cubes.

For a specific standard dimension, if you do not select any custom member name formats (that is if you do
not click the Use custom format link in the General tab), the following formats are deployed by default in
SAP NetWeaver BW cubes:

® code is deployed as an SAP NetWeaver BW short description
e short description is deployed as an SAP NetWeaver BW medium description
® |ong description is deployed as an SAP NetWeaver BW long description

If you select three member name formats, the following formats are deployed in SAP NetWeaver BW cubes:
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e the first selected in the checkbox list is deployed as an SAP NetWeaver BW short description
e the second selected in the checkbox list is deployed as an SAP NetWeaver BW medium description
e the third selected in the checkbox list is deployed as an SAP NetWeaver BW long description

If you select a fourth format, a message appears in the Issue To Resolve tab and you cannot deploy the
cube.

In concatenated formats, there are no spaces on either side of the hyphen (for example: "code-short
description").

If the member names exceed a certain number of characters, they are truncated when deployed:

e short descriptions are limited to 20 characters
® medium descriptions are limited to 40 characters
e |ong descriptions are limited to 60 characters

4.7.3.1 Choosing a Name for all the Members of Standard
Dimensions

Procedure

In the tree structure part of the window, select Dimensions.
Select the Member Properties tab.

Select the naming type you want from the Formats column.

A owopoe

Select the naming type you want to apply by default to all the members, selecting the appropriate option in
the Default format.

473.2 Changing the Name and Add a Prefix and/or a
Suffix to the Name of all the Members for a
Standard Dimension

Procedure

1. Inthe tree structure part of the window, select the appropriate dimension.
2. Select the General tab.

3. Inthe Member properties area, the default format name chosen for all the members of standard
dimensions is displayed.

4. If you want to change this name, click the Use custom format link.
The Member properties area is enabled.

5. Select the naming type you want.

6. If you want to add a prefix to the member, enter the prefix you want in the Member Prefix field.
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i Note
To enter the prefix you want for each language, click the Translation tab.

7. If you want to add a suffix to the member, enter the suffix you want in the Member Suffix field.
i Note

To enter the suffix you want for each language, click the Translation tab.

! Restriction
Prefixes and suffixes are not taken into account for an SAP NetWeaver Business Warehouse
deployment.

! Restriction

for SAP HANA deployments, prefixes and suffixes are not supported; entering texts in various
languages using the Translation tab is not supported.

473.3 Adding Member Names for all the Members of all
Standard Dimensions

Procedure

In the tree structure part of the window, select the Dimensions node.

Select the Member Properties tab.

Select the naming type you want from the Formats column.

A wop o

Enter a name of your choosing in the languages available.

i Note

To enter the name you want for each language, click the Translation tab.

| Restriction

for SAP HANA deployments, entering texts in various languages using the Translation tab is not
supported.
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4.7.3.4 Add Member Names for all the Members of a
Standard Dimension

Procedure

1. Inthe tree structure part of the window, select the appropriate dimension.
2. Select the General tab.

i Note

If you have already added member names for all the members of all standard dimensions, one or
several naming types are already checked in the Formats column of the Member properties area.

3. If you want to change the member names, click the Use custom format link.
The Member properties area is enabled.

4. Select the naming types you want.

i Note

To enter the name you want for each language, click the Translation tab.

| Restriction

for SAP HANA deployments, entering texts in various languages using the Translation tab is not
supported.

4.7.4 Start and End Date Definition for Periods

You can define all the periods to make available for selection in the Period and Data Entry Period dimensions by
choosing the start and the end year.
i Note

Once you have defined the dates, all the periods between the start and the end dates are available for
selection in the Members area for the Period and Data Entry Period dimensions.

As far as the fiscal year is concerned, you can also choose the start month. To be consistent, you must choose
the same start month that is defined in Financial Consolidation.
! Restriction

for SAP HANA deployments, the fiscal year is not supported. The start and end dates are taken into
account for the gregorian hierarchy.
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4741 Defining the Dates for Periods
Procedure

Select | Tools » Options .
Select the Periods tab.
Define the start and end year.
Click the Apply button.

In the General tab of the appropriate solution, select the start month (for the fiscal year) from the Start
Month drop-down menu.

o s W

i Note

To be consistent, you must choose the same start month that is defined in Financial Consolidation.

4.7.5 Member Name for the Period and Data Entry Period
Dimensions

| Restriction

this section does not apply to SAP HANA deployments. The only format that is applied to the gregorian
hierarchy is the following: YY/YY.MM

i Note
The Period dimension is considered as 'Time' type dimension in a cube.
In the General tab of the Period and Data Entry Period dimensions, you can choose a format defining how the

name of the members should appear in the future deployment. The names can appear differently for each
dimension, depending on which dimension you have selected.

You choose a type of name for all the members of the dimension as they will appear in the future deployment,
using templates and adding the text you want.

The available templates are the following: [Month], [Mon], [MM], [YYYY]and [YY].

You can combine several templates and add any text, characters or punctuation you want.

i Note

If you have chosen a member prefix or suffix or both, they will be added before and after the text entered in
the Period Format field.
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Example

In the Period Format field :
e 'FY'and'-'have been entered.

® [YY]and[Month]templates have been dragged and dropped from the Templates section.

The defined period format 'FY[YY] - [Month]' will appear as for example: FYO6 - January

Example

With the Period 2006.03 in the SAP Financial Consolidation database, the results using all the different formats
will be as follows:

e [Month]: March
e [Mon]: Mar

e [MM]: 03

e [YYYY]: 2006
e [YY]: 06

4.7.6 Member Selection for Standard Dimensions

For each dimension, you will now choose the dimension members you want to include in the future
deployment.

To make the selection of the members easier:

e Open the Selection tab to use filtering criteria to limit which members are displayed.
® QOpen the Filters & Characteristics tab to use the filters or characteristics defined in the SAP Financial
Consolidation database.

Members taken into account for SAP HANA deployments

When working on a SAP HANA deployment:

e Forincluded dimensions, all members are taken into account by default and you cannot perform your own
member selection.

e For excluded dimensions, you can choose to make your own selection of members. The member selection
defines how data is filtered in the analytic view.

i Note

Here are a few examples of member selection for excluded dimensions:

o Exclude the Scope dimension from the view but select its member "Corporate": in a report, you will
see data for the Corporate scope.
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o Exclude the Audit ID dimension from the view but select all its members: in a report, you will see
data for all aggregated audit IDs.

o Exclude the Share dimension from the view but select its NA member: in a report, you will see data
not detailed by share.

Related Information

Custom Filtering [page 47]

Standard Dimensions Exclusion [page 66]

4.76.1 Custom Filtering

To make the selection of the members easier, you can open the Selection tab to use filtering criteria to limit
which members are displayed.

You can access this tab by selecting | View » Dimensions ¥ [dimension] » Members » Selection 3.

The Member Display Filter Groupbox

The following elements can be used to limit which members are displayed:

e Todisplay members containing the same text, enter the text in the Search for members containing field.
Next, open the Match against column drop-down menu and select the column in which the entered text
should appear. Finally, click the Apply button.

->Tip
If you want the search to be case sensitive, select the Filtering is case sensitive option.
e Todisplay only the members you have selected in the Elements groupbox, select the Display selected

members only option.
® You can sort a column in ascending or descending order. This can be done by selecting the column name

from the Sort column drop-down menu.
The Members Groubox

The Members groupbox displays the members, depending on the filtering applied. This is where you select the
members you want to take into account.
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The Select all members Groubox

The option Select all members enables you to select all the members belonging to the dimension, and not just
the ones that are displayed in the Members groupbox. By default, any member added to the SAP Financial
Consolidation structure is retrieved in cube designer. However, these new members are not automatically
selected in cube designer, which means that they do not factor into the existing cube definition. To avoid having
to manually select these new members, click the Select all members option. This way, the members will be
added to the cube in the next deployment.

i Note

for SAP HANA deployments, the Select all members option is selected by default and cannot be changed
for included dimensions. Note that there is no need to redeploy a SAP HANA deployment when members
are added to the SAP Financial Consolidation structure: since the attribute views are based on the Financial
Consolidation tables, the attribute views are synchronized with the tables. In other words, when members
are added to the tables, they are visible in the views.

The Select all members option equals "All values" in Financial Consolidation.

Member Selection for Detailed Dimensions

For a detailed dimension, you can:

e Select the members you want to take into account by selecting all the members or speficic members.

® |nclude the NA member. To do so, use the Include NA Member option. The NA member equals "No value" in
Financial Consolidation.

i Note

for SAP HANA deployments, the NA member will be retrieved as follows in the reports: No [dimension
name].

e Specify how the “All" member amount will be calculated: the "All" member will take the aggregation of all
the detailed amounts, or the "All" member will take only the amount of the NA member, or the "All"
member will take the aggregation of all the detailed amounts and the NA member amount. To specify this,
use the ‘All'member calculation drop-down menu.

| Restriction

for SAP HANA deployments, the ‘All'member calculation drop-down menu is not available.

Characters you can use in the Search for members containing field

e |jterals like abc will match any element name containing at least one occurrence of 'abc'. This is case
sensistive.

® *means zero or more, + means one or more. So a+bc will match any string containing a followed by one or
more b followed by a c.
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® You can group literals using [] so [ae]will match any string containing a single a or e. Hence gr[ae]y will
match 'gray' or 'grey' (but not 'graey")

® You can use a hyphen to indicate ranges. E.g. [0-9]will match any number. [0-97* will match a sequence of
zero or more numbers. [A-Za-z] will match any single upper or lower case letter.

® You can connect multiples of these together to form more complex filters. E.g [A-Za-z]+[0-9]+ will match
any element name that starts with 1 or more letters and is followed by 1 or more numbers.

e A carat will negate a matched set, so a[*"b]matches an a followed by a character other than b. [*0-9]
therefore matches any non-numeric character.

® You can do case insensitive matches using /i -- so /iABC will match 'AccountABC', 'AccountAbC',
'Accountabc’, "CompanyABC", "abcDEF", etc.

e Ameans the start of the element name and $ the end of the name. E.g. *A matches names starting with A,
[0-9]1% matches names ending in a number.

e Besides using * and + for repetition you can specify how many occurenes between n and m times using
{n,m}. E.g. A[0-9]{1,3} will match elements containing an A followed by between 1 and 3 numbers.

® The vertical bar | means or. So to match any element containing ABC, XYZ or 123 use ABC|XYZ|123.

e A (?)matches any single character. For example, to search for the period 2000.12, you type: 2000712 in
the "search" function.

Example

Following are some examples:

e ABC simply matches elements which contain ABC
e AABC matches elements starting with ABC
e AABC[0-9]* - Matches element names of the form ABCxxx where xxx is a sequence of numbers

e [A-Za-z_][A-Za-z0-9_]* - Matches element names that start with a letter or underscore followed by zero or
more letters, numbers or underscores.

Related Information

SAP Financial Consolidation Filtering [page 49]

4.76.2 SAP Financial Consolidation Filtering

To make the selection of the members easier, you can open the Filters & Characteristics tab to use the filters or
characteristics defined in the SAP Financial Consolidation database.

| Restriction

The Filters & Characteristics tab is not available for SAP HANA deployments.

You can access this tab by selecting | View » Dimensions # [dimension] » Members » Filters &

Characteristics .
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The Filters & Characteristics tab includes:

e The Financial Consolidation Filters & Characteristics groupbox.
You can use the following elements to help you select the members:

o Filter selection. To select filters, click the By Filter button. In the Select Filter dialog box that appears,
select one or more filters and click the OK button.

o Characteristics selection. To select characteristics, click the By Characteristic button. In the Select
Characteristic dialog box that appears, select one characteristic and the elements you want, then click
the OK button.

o Once you have selected a filter or a characteristic, the members that are included in the filter or
characteristic appear in black in the Members groupbox and the Lock Selection to Filter/Characteristic
option is automatically selected. If you want to select additional members, deselect the option. You will
be able to select other members (which are otherwise grayed out).

® The Members groupbox. This groupbox displays the members contained in the filter(s) or characteristic(s)
selected. This is where you select the members you want to take into account.

476.3 Selecting Members for a Standard Dimension

Procedure

1. Select the appropriate standard dimension.

2. Select the Members tab.

3. Select the Selection or the Filters & Characteristics tab.
! Restriction

The Filters & Characteristics tab is not available for SAP HANA deployments.

4. Inthe Members groupbox, check the boxes corresponding to the members you want to take into account.
- Tip

Following are some tips for selecting the members:

o To select all the members displayed, click the Select Visible button.

o To deselect all the members displayed, click the Deselect Visible button.

o To select the deselected members and deselect the selected ones, click the Invert Selection button.
o Toreset the selection to its default setting, click the Reset button.

->Tip

You can use filtering criteria to limit which members are displayed. To find out more about filtering,
see above.
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4.7.7 Hierarchy Selection

Three types of hierarchy are available:

Default hierarchy. A default hierarchy consists of one node grouping together a simple list of elements.
However, OLAP cubes consider this to be a hierarchy.

Parent Child hierarchy. The SAP Financial Consolidation characteristics that belong to the same reference
table as the dimension to which they are assigned are changed into "Parent Child hierarchies".

i Note

The rollup unit and account hierarchies in SAP Financial Consolidation are treated like Parent Child
hierarchies.

i Note

When you select a rollup hierarchy, the Elimination dimension is automatically included in the cube. You
can select a rollup hierarchy for the following dimensions: Reporting Unit, Original Reporting Unit or
Management Unit. See the section below for details about defining consolidations and eliminations
with two rollup hierarchies.

i Note

For SAP NetWeaver Business Warehouse (SAP NetWeaver BW) cube deployments only, you can select
several Parent Child hierarchies per dimension and per cube with only one Scope Entity hierarchy or
Category Scenario Account hierarchy.

A\ Caution

Some SAP Financial Consolidation characteristics linked to a dimension contain circular references.
Therefore, they will not be changed into a Parent Child hierarchy. The deployment will then fail.

Named level hierarchies. The SAP Financial Consolidation characteristics that do not belong to the same
reference table as the dimension to which they are assigned are changed into "Named level hierarchies".

A\ Caution

Financial Consolidation characteristics based on the same reference table part of a named-level
hierarchy. SAP Financial Consolidation characteristics based on the same reference table (meaning
characteristics that belong to the same reference table as the dimension to which they are assigned)
can be part of a named-level hierarchy in cube designer. However, if you select a characteristic based
on the same reference table in the Characteristics area of the Hierarchies tab, note that SAP does not
guarantee that it will be supported and therefore, intermediate totals in the hierarchy may be incorrect
- in both SSAS cubes and SAP NetWeaver BW cubes.

If you are using an SAP Financial Consolidation database, other hierarchies are available for the Account,
Reporting Unit and Origin Unit dimensions.

For the Reporting Unit or the Origin Unit dimensions, you can select Scope Entity Hierarchy. The hierarchies
available in the drop-down menu depend on the scopes previously selected. When you select a scope
hierarchy, the members of the scope linked to this scope hierarchy will automatically be selected in the
Members tab.
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| Restriction

If you select a scope entity hierarchy in either one of the two dimensions, the selection will not be
available for the other dimension.

e For the Account dimension, you can select a Category Scenario Account Hierarchy. The hierarchies
available in the drop-down menu depend on the members selected in the Category dimension.

i Note

If you chose to historize the scope hierarchies, the Parent child hierarchy cannot be changed for the
Reporting Unit dimension.

| Restriction

The options Scope Entity Hierarchy and Category Scenario Account Hierarchy are not supported for a SAP
HANA deployments.

If you do not select a hierarchy or you select the Include default hierarchy option, the default hierarchy will be
applied in the future cube.

i Note

In order to obtain a simple cube, you should select only one hierarchy per dimension and per cube.

i Note

If you have already selected a hierarchy, you are advised not to select the Include default hierarchy option.

You can also specify that you do not want the name of the dimension to appear in the retrieval tool by selecting
the Hide dimension name option. In this case, only the selected hierarchy name will appear.

| Restriction

The Hide dimension name function is not taken into account for SAP NetWeaver BW deployments.

| Restriction

The Hide dimension name function is not supported for a SAP HANA deployments.

Defining consolidations and eliminations with two rollup hierarchies

For SSAS deployments, you can define eliminations and consolidations with two rollup hierarchies.

1. You choose the first rollup hierarchy for the dimension Reporting Unit or Original Reporting Unit, by
selecting Include (which is not selected by default) in the Scope Entity Hierarchy area, and then selecting
the rollup hierarchy from dropdown list.

2. Therollup hierarchy you have selected for the first rollup hierarchy is automatically taken into account as
the second hierarchy for the dimension Management Unit and Original Reporting Unit (if not already used
as the first hierarchy). The option Include in the Secondary Scope Hierarchy area is selected for both
dimensions. You can choose to not include the hierarchy for one of the two dimensions.
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When you select a rollup hierarchy, the members of the scope linked to this hierarchy are automatically
selected in the Members tab of the dimensions.

Additional Hierarchies for SAP HANA deployments

For each analysis dimension included in the view, the "main hierarchy" is automatically created. This hierarchy
is not visible in cube designer but will be visible in the retrieval tools. The "main hierarchy" is composed of the
following nodes at the same hierarchical level:

e All [dimension name]: The member "All" takes the aggregation of all the detailed amounts of its child
members.

e No [dimension name]: The member "No" is the not-detailed member that is included provided that the
option Include NA Member is selected.

For the Period and the Data Entry Period dimensions, the calendar hierarchy called "gregorian hierarchy" is
automatically created. This hierarchy is not visible in cube designer but will be visible in the retrieval tools. This
hierarchy starts in January and ends in December. The hierarchy format is the following: YY/YY.MM.

4.7.7.1 Parent Child hierarchies and Data Members

Data members can be created automatically on the Parent Child hierarchies of the following dimensions:

® Detailed dimensions.
® Reporting Unit dimension.
e QOriginal Reporting Unit dimension.

By default, data members are created automatically by default; however, you can choose not to create them.

| Restriction

Even if the appropriate option is selected, data members are not included in SAP NetWeaver BW cubes.

! Restriction

Data members are not supported for SAP HANA deployments.

Example

In the example below, the total is the same in both cases. Only the display is different.

The data member for Ul has been automatically created.
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U1 =50

— U1 data =25
— U2=15
U3=10

The data member for Ul has not been created.

U1 =350

—U2=15
u3=10

4.771.1 Choosing Data Members not to be Created

Context

The data members are created automatically by default on the Parent Child hierarchies of some dimensions.
You can choose not to create them.

Procedure

1. Select | Tools ¥ Options .
The Options dialog box appears.

2. Inthe General tab, deselect the Include Data Member option.
3. Clickon OK.

Results

| Restriction

Even if the appropriate option is selected, data members are not included in SAP NetWeaver BW cubes.

| Restriction

Data members are not supported for SAP HANA deployments.
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4772  Aggregation Definition

For all dimensions except for Category, Scope, Variant and Consolidation Currency, two options are available. If
you select these options, the parent node will contain the aggregated total of its children amounts.

e The Enable Named Level Hierarchy Aggregations option applies to the named level and the default
hierarchies.

e The Enable Parent Child Hierarchy Aggregations option applies to parent child hierarchies.

i Note

For the Period, Data entry period and Account dimensions, the Enable Parent Child Hierarchy Aggregations
option does not appear. However, you can activate this option for the Account dimension by setting the
following key in the Cartesis.InformationDelivery.Workbench.exe.config file: <add

key="IsAccountDimensionAggregatable" value="true"/>

Concurrently, for aggregatable hierarchies, you can deactivate the calculation at the "All" node level when not
relevant. The Deactivate 'All' node calculation option applies to all types of hierarchies of the dimension. When
the option is selected, the behavior is as follows in your data retrieval tool:

e The 'All'node is neither displayed nor calculated on a default hierarchy.
e The 'All' node is displayed but not calculated on the named level and parent child hierarchies.

| Restriction

For SAP NetWeaver Business Warehouse deployments:

o The aggregation is always performed on all members (except for the Account dimension), whether
the aggregation options have been selected or not.

o When the aggregation options are selected, on an Account parent child hierarchy, the aggregations
are automatically activated also on the named level hierarchy.

| Restriction

For SAP HANA deployments, the options Enable Named Level Hierarchy Aggregations, Enable Parent
Child Hierarchy Aggregations and Deactivate 'All' node calculation are not supported. The aggregation is
always performed on all selected members.

4.77.3 Automatic Aggregations Enabled on the Period and
Data Entry Period Dimension Hierarchies

You can choose to apply a different behavior on time aggregation by activating the automatic time aggregation
based on SAP Financial Consolidation flow types. To do so, you will choose from the Flow dimension an SAP
Financial Consolidation category scenario that will be used as a reference.

The behavior of the flows will be as described in the selected SAP Financial Consolidation category scenario.

The time aggregation will apply to both period and data entry period dimensions, provided that they are not
merged. This means that the behavior of the accounts will be driven by the selected flow as shown below:
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Financial Consolidation Flow type Aggregation mode in the cube

Year To Date Last non empty period

Periodic (Monthly) Sum

Opening flow First non empty period

Closing flow Last non empty period

Movement flows Last non empty period

Other flows Last non empty period
i Note

The default aggregation mode is the sum.

| Restriction

This function will not be taken into account for a SAP NetWeaver Business Warehouse (SAP NetWeaver
BW) deployment.

| Restriction

For SAP HANA deployments, this feature is not supported.

Example

The examples below describe the three different aggregation modes and therefore, which amounts will be
displayed in your data retrieval tool. No amount has been entered in March.

In the table below, the aggregation mode is 'Last non empty period'.

In this example, as no amount has been entered for March, the amount in Quarter 1is the amount in February,
since it is the last amount that has been entered.

January 5
February 2
March -
Quarter1 | 2

In the table below, the aggregation mode is 'Sum'.

In this example, all the entered amounts are added.

January 5
February 2
March -
Quarter1 | 7
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In the table below, the aggregation mode is 'First non empty period'.

In this example, the amount in Quarter 1is the first amount that has been entered, which is the amount in
January.

January 5
February 2
March -
CQuarter1 | 5

Related Information

Activating Automatic Time Aggregation [page 57]

47731 Activating Automatic Time Aggregation

Prerequisites

This function will not be taken into account for an SAP NetWeaver Business Warehouse (SAP NetWeaver BW)
deployment.

Procedure

1. Select the Flow dimension.
2. Select the General tab.

3. Select the category scenario you want from the Defining Category Scenario drop-down menu.

Results

i Note

If you do not want to apply the automatic time aggregation, select None from the drop-down menu.
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4774  Hierarchy Selection and Definition for the Period

and Data Entry Period Dimensions

| Restriction

This section does not apply to SAP HANA deployments

For each dimension, the fiscal hierarchy is automatically included for deployment and its start month is the one
you have defined for the solution. To be consistent, you must choose the same start month that is defined in

Financial Consolidation.

You can choose to also include the calendar hierarchy, which start month is always January.

i Note

For the fiscal hierarchy, you choose April 2010 as the start month. Here is how the fiscal hierarchy and the

calendar hierarchy will be structured.
Fiscal hierarchy:

Year 2010-2011

Semester 1

Quarter 1

April 2010

May 2010

June 2010

Quarter 2

July 2010

August 2010

September 2010

Semester 2

Quarter 3

October 2010

November 2010

December 2010

Quarter 4

January 2011

February 2011

March 2011

Calendar hierarchy:

Year 2010

Semester 1

58 PUBLIC

SAP Financial Consolidation Cube Designer User Guide

Views



Quarter 1

January 2010

February 2010

March 2010

Quarter 2

April 2010

May 2010

June 2010

Semester 2

Quarter 3

July 2010

August 2010

September 2010

Quarter 4

October 2010

November 2010

December 2010

You can define independent formatting for the fiscal and calendar hierarchies.

You can access the Hierarchies tab by selecting |# View #» Dimensions ¥ [dimension] ¥ Hierarchies 3

In the Hierarchies tab of the Period or Data Entry Period dimensions, you can perform the following actions:

e Select a default member for the hierarchies, using the Edit button next to the Default Member field. If only
the fiscal hierarchy is included, you can select any member as the default member. If you also include the
calendar hierarchy, you can only set a member that is not a node as the default member for both
hierarchies. If you select a node as the default member, a message appears, explaining that the calendar
hierarchy has been deselected. If you want to include the calendar hierarchy again, you must first perform
a clear on the default member.

e Define the format for the fiscal hierarchy. To do so, select the format you want from the Fiscal Hierarchy
Format drop-down menu. The format you have chosen appears in the Selected Hierarchies area.

e |nclude the calendar hierarchy and define its format. To do so, click the Include Calendar Hierarchy option
and select the format you want from the drop-down menu. The hierarchy and the format you have chosen
appears in the Selected Hierarchies area.

i Note
If you choose Code from one of the format drop-down menus, the hierarchy will appear as a list.

® QOrder the year members by ascending or descending order, using the Year Descending Order option. By
default, the years are in ascending order and the option is not checked. The members inside the year
nodes are unchanged.

SAP Financial Consolidation Cube Designer User Guide
Views PUBLIC 59



i Note

If Code is selected for either the Fiscal Hierarchy Format or the Include Calendar Hierarchy option, the
Year Descending Order is not activated.

i Note

If you select both calendar and fiscal hierarchies, so that the hierarchies are correctly ordered, select
Year for both hierarchies.

e Choose to add a year prefix or suffix to the quarters or semesters. You can also choose the format for the
year prefix or suffix: YY or YYYY.

| Restriction

Prefixes and suffixes will not be taken into account for a SAP NetWeaver Business Warehouse (SAP
NetWeaver BW) deployment.

e Define and translate the names of semesters and quarters as they will appear in the reports. You can do so
in the Translation tab.

i Note

The Half Year Captions or Quarter Captions are not available if semesters or quarters are not part of the
hierarchy format you have chosen.

Related Information

Start and End Date Definition for Periods [page 44]

4.7.71.5 General Actions on Hierarchies

After selecting a hierarchy, you can:

® Rename and translate a hierarchy.

| Restriction

For SAP NetWeaver Business Warehouse (SAP NetWeaver BW) deployments, the name of a hierarchy
must not exceed 60 characters. In this case, an issue to resolve will occur and you will have to modify
the name of the hierarchy.

| Restriction

For SAP HANA deployments, you cannot translate a hierarchy name.

e Select a default member for a hierarchy. Even if several hierarchies are selected, you can choose a default
member from among the members of a single hierarchy.
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o |If several hierarchies are selected, including a Parent Child hierarchy, the members of the Parent Child
hierarchy will be available for selection.

o If several hierarchies are selected, not including a Parent Child hierarchy, the members of the flat list
(default hierarchy) will be available for selection.

e Enter aname in each language for the "All" node of a hierarchy.
! Restriction
Not for SAP HANA deployments.

e Sortineach level of a hierarchy:
o By code. This is the default sort method.

! Restriction
For SAP HANA deployments you can only sort by code.
o By internal identifier. These are the SAP Financial Consolidation database identifiers.

o By additional descriptions, selected for dimension members.

o By attribute. If a characteristic is defined as an attribute, you can sort the hierarchy by attribute (only
at the leaf level of the hierarchy).

i Note

When a sort is performed at the leaf level of a hierarchy, the sort will be applied to each level of any
hierarchy selected for this dimension.

e Suppress all the leaf members and keep only the nodes of a Named level hierarchy.

! Restriction
Not for SAP HANA deployments.

| Restriction

None of the following functions are taken into account in a SAP NetWeaver BW deployment: selecting a
default member for a hierarchy, naming the "All" node in several languages, sorting in each level of a
hierarchy and deleting all the leaf members of a Named level hierarchy.

Actions on Hierarchies for SAP HANA deployments

After selecting a hierarchy, you can:

® Rename a hierarchy.

e Sortineach level of a hierarchy:
o By code. This is the default sort method.
o By internal identifier. These are the SAP Financial Consolidation database identifiers.
o By additional descriptions, selected for dimension members.

o By attribute. If a characteristic is defined as an attribute, you can sort the hierarchy by attribute (only
at the leaf level of the hierarchy).
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i Note

When a sort is performed at the leaf level of a hierarchy, the sort will be applied to each level of any
hierarchy selected for this dimension.

e Suppress all the leaf members and keep only the nodes of a Named level hierarchy.

Related Information

Renaming a Hierarchy [page 62]

Translating a Hierarchy [page 63]

Selecting a Default Member for a Hierarchy [page 63]
Setting a Name for the "All" Node of a Hierarchy [page 64]

4.7.7.5.1 Selecting a Hierarchy

Prerequisites

For SAP NetWeaver Business Warehouse (SAP NetWeaver BW) cube deployments only, you can select several
Parent Child hierarchies per dimension and per cube.

Procedure

In the Characteristics or Self-referenced characteristics groupboxes, select the hierarchy required by checking
the boxes. In terms of the Account and Reporting Unit dimensions, check the Include option in order to be able
to select a hierarchy from the drop-down menu.

The hierarchy appears in the Selected Hierarchies groupbox.

4.7.75.2 Renaming a Hierarchy

Prerequisites

For SAP NetWevaver Business Warehouse deployments, the name of a hierarchy must not exceed 60
characters. In this case, an issue to resolve will occur and you will have to modify the name of the hierarchy.
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Procedure

1. Inthe Selected Hierarchies groupbox, right-click on the appropriate hierarchy and select Rename.
The name of the hierarchy appears highlighted.

2. Enter the new name.

i Note

You can also rename the hierarchy in the Translation tab.

4.7.7.5.3 Translating a Hierarchy

Prerequisites

For SAP NetWevaver Business Intelligence deployments, the name of a hierarchy must not exceed 60
characters. In this case, an issue to resolve will occur and you will have to modify the name of the hierarchy.
Procedure

1. Select the Translation tab.

2. Enter the translations for each language.

4.775.4 Selecting a Default Member for a Hierarchy

Prerequisites

The default member will not be taken into account for a SAP NetWeaver Business Warehouse (SAP NetWeaver
BW) deployment.

Procedure

1. Inthe Hierarchies tab, click the Edit button next to the Default Member field.
The Choose The Default Member dialog box appears.

2. Select the member you want to be the default member.

3. Click the OK button.
The default member appears in the Default Member field.

SAP Financial Consolidation Cube Designer User Guide
Views PUBLIC 63



Results

i Note

You can then remove the default member by clicking the Clear button.

4.7.7.5.5 Setting a Name for the "All" Node of a Hierarchy

Prerequisites

The names of the "All" node will not be taken into account in a SAP NetWeaver Business Warehouse (SAP
NetWeaver BW) deployment.

Procedure

1. Select the Translation tab.
2. Enter the text you want for each language.
3. Click the OK button.

4.7.7.5.6 Sorting Hierarchies

Prerequisites

The Order by Attribute option is not available for an SAP NetWeaver Business Warehouse (SAP NetWeaver BW)
deployment.

Procedure

1. Inthe Selected Hierarchies groupbox, right-click on the appropriate hierarchy level and select Order by
Attribute.
The Select an ordering attribute dialog box appears.

2. Select the element on which you want the sort to be performed (code, internal identifier or an attribute).
3. Click the OK button.

SAP Financial Consolidation Cube Designer User Guide
64 PUBLIC Views



Related Information

General Actions on Hierarchies [page 60]

4.7.7.5.7 Deleting the Leaf Members and Keep only the
Nodes of a Hierarchy

Context

You can delete the leaf members only for a Named level hierarchy.

i Note

This funtion will not be taken into account for an SAP NetWeaver Business Warehouse (SAP NetWeaver
BW) deployment.

Procedure

In the Selected Hierarchies groupbox, right-click on the top most level of the hierarchy (the name of the
hierarchy) and select Suppress Dimension Member.
The leaf level is greyed out.

4.7.8 Attribute Selection

For each dimension (except for the Period and Data entry period dimensions), you can select the attributes you
want to load in the cube by selecting the following elements:

i Note

For SAP HANA deployments, the attributes are automatically selected when you select characteristics in
the Hierarchies tab. In addition, you can select further attributes.

e Self-referenced characteristics.

i Note

Inan SAP NetWeaver Business Warehouse (SAP NetWeaver BW) deployment, the attributes based on
self-referenced characteristics are converted into "Navigation Attributes" in the InfoCube.

e (Characteristics.
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i Note

In an SAP NetWeaver Business Warehouse (SAP NetWeaver BW) deployment, the attributes based on
self-referenced characteristics are converted into "Navigation Attributes" in the InfoCube.

® Properties.

| Restriction

The attributes based on boolean and text properties will not be taken into account for an SAP
NetWeaver BW deployment.

These characteristics and properties are the ones defined for the dimension in SAP Financial Consolidation.
They are treated as attributes. The benefits are:

e Ability to perform advanced selections based on attributes and filtering expressions such as is / is not,
combined conditions, etc.

® Presentation enhancement such as the ability to create a calculated description of a member + a
characteristic.

The attribute name can be customized by the user to fit with OLAP analysis needs.

i Note

In some cases, if SAP Financial Consolidation characteristics are selected as hierarchies, they will
automatically be considered as attributes.

e The upper part of the screen displays all the self-characteristics, characteristics and properties that are
defined in SAP Financial Consolidation for the selected dimension.
e \When you select one of them, it appears in the Translation tab.

® You can then rename the characteristic or property in the different languages available by clicking in the
Translation tab and entering the text of your choice.

4.7.9 Standard Dimensions Exclusion

You chose a specific number of dimensions when creating the solution.

However, you can choose not to use specific dimensions. In other words, you can specify that you do not want
some dimensions to be included in the future cube. If you exclude a dimension, the name of the dimension and
the names of the members will not appear. However, the amount will appear in the cube as follows:

e |f you manually select some members, the total amount of the selected members (in the Members tab) will
be exported.

e |fyou select the Select all members option, the total amount of all the dimension members will be
exported.

Once a dimension is excluded, you will then be able to include it again.
i Note

Here are a few examples of member selection for excluded dimensions:

® [Exclude the Scope dimension from the view but select its member "Corporate": in a report, you will see
data for the Corporate scope.
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e FExclude the Audit ID dimension from the view but select all its members: in a report, you will see data
for all aggregated audit IDs.

e Exclude the Share dimension from the view but select its NA member: in a report, you will see data not
detailed by share.

4791 Excluding a Standard Dimension

Procedure

1. Inthe tree structure part of the window, select the appropriate dimension.
2. Select the General tab.

3. Check the Exclude dimension box.
In the tree structure part of the window, the excluded dimension appears in italics.

Results

i Note

You can also exclude a dimension by right-clicking on it in the tree structure and by selecting Exclude. By
default, all the members of the dimension will be aggregated.

i Note

To reinclude an excluded dimension, uncheck the Exclude dimension box.
i Note

You can also exclude or include all the standard dimensions by right-clicking on the Dimensions node in the
tree structure and by selecting Exclude All Dimensions or Include All Dimensions.

4.7.10 Hide Excluded Dimensions

You can hide or show the excluded dimensions that will not be deployed in the cube.

Hiding excluded dimensions enables you to mask information that is not pertinent.
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4.7.10.1 Hiding Excluded Dimensions

Procedure

1. Select|r Tools » Options ¥ Display Jtab.

2. Check the Hide Excluded Dimensions box.
In the tree structure part of the window, the excluded dimensions no longer appear.

Results

i Note

To show the excluded dimensions again, uncheck the Hide Excluded Dimensions box.

4.7.11 Database and Cube Structure Synchronization

For each standard dimension, you can define synchronizing intervals so that the cube structure is consistent
with the SAP Financial Consolidation database. The members of dimensions that have been added, modified or
deleted in the SAP Financial Consolidation database tables will be synchronized.

If you do not activate the synchronization, the cube structure will remain in the same state it was in when you
defined the dimensions. To refresh the cube structure, you will need to deploy or process the cube again.

A Caution

This synchronization only works if you have selected the members of the dimensions using characteristics.

i Note

If you chose to historize the scope hierarchies when creating the view, the Live Access tab is disabled for
the Reporting Unit dimension.

i Note

This function is not supported for SAP NetWeaver Business Warehouse (SAP NetWeaver BW)
deployments, nor for SAP HANA deployments.

i Note

For SAP HANAdeployments, this synchronization mechanism is not needed. The attribute views are based
on the Financial Consolidation tables and are therefore automatically synchronized.

The intervals are as follows:
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e Query Poll Interval. This option enables you to tell the system when to scan all the SAP Financial
Consolidation tables in order to detect modifications. If modifications are detected, the system processes
the synchonization. See example 1 below.

e Silence interval and Silence override interval.
These intervals will perform a partial update. The complete interval to update the cube will be Query Poll
Interval + Silence interval or Silence override interval. See example 2 below.

i Note

If the user does not use the options in the Advanced part, the delay interval to update the cube will be
by default equal to the Query Poll Interval + 1 second.

® Rebuild interval. This allows you to specify how often the cube should be completely processed, regardless

of whether the structure has been modified or not. See example 3 below.

Example

If you specify the information below, the tables will be scanned every 5 minutes.

Query Poll Interval 5 Minutes

Example

If you specify the information below, when the dimension is modified, the system waits until there are no
modifications made in SAP Financial Consolidation database for 10 minutes and then synchronizes the
dimension members. If, however, there is no 10 minute break in the modifications, the system will synchronize
the dimension members after 20 minutes (Silence Override Interval value).

Silence interval 10 Minutes
Silence override interval 20 Minutes
Example

If you specify the information below, the cube will be entirely synchronized with the dimension structure every
two hours even if no modifications have been made.

Rebuild interval 2 Hours
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4.7.11.1 Enabling the Dimension Member Synchronization

Procedure

1. Inthe tree structure part of the window, select the appropriate dimension.

2. Select the Live Access tab.

3. Check the Activate live access box.

4. Define what you want in the Query Poll Interval field and drop-down menu.

5. Click the Advanced button to define the other elements. This is optional.

6. Inthe Cache Settings groupbox, define the different elements. This is optional.

4.8 View Copy

You can copy and paste a view in a solution.

When you do so, you also automatically copy and paste the view's deployments.
Once you have copied a view, you can rename it.
Related Information

Renaming a View [page 71]

4.8.1 Copying and Pasting a View
Procedure

1. Inthe tree structure part of the window, right-click on the view you want to copy and select Copy.

2. Right-click on the solution you want the view to be copied in and select Paste.
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4.9 Renaming a View

Procedure

1. Inthe tree structure part of the window, right-click on the view you want to rename and select Rename
The name of the view appears highlighted.

2. Enter the new name.

SAP Financial Consolidation Cube Designer User Guide
Views PUBLIC 71



5 Cube Deployments

5.1 Introduction to Cube Deployments

You can create three types of deployments:

e SSAS cube deployments
e SAP NetWeaver Business Warehouse (SAP NetWeaver BW) cube deployments
e SAP HANA deployments

Related Information

SSAS Cube Deployments [page 72]
SAP NetWeaver Business Warehouse Cube Deployments [page 88]
SAP HANA Deployments [page 103]

5.2 SSAS Cube Deployments

You will now create an SSAS cube deployment.
Once a deployment has been created, you will carry out the following steps:

e Entering deployment and cube information

e Specify the automatic creation of the universe associated to the cube.
e Synchronizing database and cube data

e C(Creating calculated members

e Using your own MDX scripts in a deployment

e Creating SSAS named sets based on SAP Financial Consolidation characteristics and filters
® Resolvingissues

e | oading external data into a cube

® Deploying and processing a cube

e Updating a deployment

e Copying a deployment

® Renaming a deployment
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Related Information

SSAS Deployment and Cube Information [page 74]
Database and Cube Data Synchronization [page 74]
Calculated Members [page 76]

Using your own MDX Scripts in a Deployment [page 79]
SSAS Named Set Creation based on SAP Financial Consolidation Characteristics and Filters [page 80]
SSAS Deployment Issue Resolution [page 81]

External Data Loading into an SSAS Cube [page 82]
SSAS Cube Deployment and Processing [page 84]
SSAS Deployment Update [page 87]

Deployment Copy [page 106]

Renaming a Deployment [page 106]

5.2.1 SSAS Deployment Creation

Creating an SSAS deployment consists of the following main steps:

e Entering a name for the deployment.
e Choosing the SSAS server. This is the server on which SSAS is installed and where the cubes will be stored.

5.211 Creating an SSAS Deployment

Procedure

1. Inthe tree structure of the main window, right-click on Deployments, then select Add Deployment.
The New Deployment dialog box opens.

2. Inthe Deployment Name field, enter the name you want to give to the deployment.
3. Inthe Server Type area, select SSAS 2005.

4. From the Target Server drop-down menu, select the SSAS server.

i Note

You will be able to select the database in the Options tab of the deployment once it is created.

The Deployer Service Url field is filled in by default. The URL comes from the
Cartesis.InformationDelivery Workbench.exe.config file, which is located in the cube designer installation
directory. You can change the URL. It will be effective for the current deployment.

i Note

If you change the URL in the file, it will be applied to all deployments.
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5. Click the OK button.

The deployment appears below Deployments.

5.2.2 SSAS Deployment and Cube Information

Carry out the following steps:

e Choose the SSAS database. You chose the SSAS database server while creating the deployment and it is
displayed in the General tab.

e Modify the name of the future cube. By default, the cube is given the deployment name.

e Choose the default language for the cube. The available languages are the ones chosen in the view. All the
languages chosen in the view will be available in the future cube, but a default language needs to be chosen
in the deployment.

e Specify the parent amounts. In the data access group you belong to in SAP Financial Consolidation, you
might not be allowed to view all the children of a specific parent. You can choose which children the parent
amount should take into account:

o The parent amount is the sum of all its children, even those which you are not allowed to see. In this
case, you will uncheck the Enable Visual Totals option.

o  The parent amount is the sum of only the children you are allowed to see. In this case, you will leave the
Enable Visual Totals option checked, as it is by default.
® (Choose a default number format.
You choose the default number format that will be taken into account for the entire SSAS cube.
You can choose a predefined format from the Measure Format drop-down menu or you can directly enter
the format of your choice in the same menu.

i Note

The format is defined at the deployment level, enabling you to apply different formats to different
deployments.

You can define all of the above elements in the Options tab of a deployment.

Related Information

Language Selection [page 23]

5.2.3 Database and Cube Data Synchronization

For each deployment, you can define synchronizing intervals so that the cube data will be consistent with the
SAP Financial Consolidation database data.

If you do not activate the synchronization, the cube data will remain as it was when you deployed the cube. To
refresh the cube data, you will need to process the cube again.
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The synchronization applies to all the tables that have been modified. If you only want to synchronize the data
related to certain data entry periods, you can select them.

A Caution

In this version, the synchronization only applies to the tables that existed when the deployment was done. If
a new consolidation table is created in the SAP Financial Consolidation database, you will need to deploy
the cube again in order to get the synchronization.

->Tip

If you want to avoid redeploying the cube, you can create and run your consolidation definitions in SAP
Financial Consolidation in advance, even if they are empty. As a consequence, all the consolidations will
appear in cube designer and will be synchronized.

The intervals are the following:

® Query Poll Interval
e Sjlence interval and Silence override interval
® Rebuild interval

5.2.3.1 Query Poll Interval

This option enables you to tell the system when to scan all the SAP Financial Consolidation tables in order to
detect modifications. If modifications are detected, the system processes the synchonization.

Example

So that the tables are scanned every 5 minutes, specify the following in the Query Poll Interval area: 5 Minutes.

5.2.3.2 Silence Interval and Silence Override Interval

These intervals will perform a partial update. The complete interval to update the cube will be Query Poll
Interval + Silence Interval or Silence Override Interval.

i Note

If the user does not use the options in the Advanced part, the delay interval to update the cube will be by
default equal to the Query Poll Interval + 1 second.
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Example

When data is modified, the system waits until there are no modifications made for 10 minutes and then
synchronizes the data and the cube. If, however, there is no 10 minute break in the modifications, the system
will synchronize the data and the cube after 20 minutes.

Silence interval: 10 Minutes.

Silence override interval: 20 Minutes

5.2.3.3 Rebuild Interval

This allows you to specify how often to synchronize the data, regardless of whether the data has been modified
or not.

Example

So that the cube is synchronized with the data every two hours even if no modifications have been made,
specify the following in the Rebuild interval area: 2 Hours.

5.2.3.4 Activating the Data Synchronization

Procedure

In the tree structure part of the window, select the appropriate deployment.
Select the Options tab.

In the Live Access groupbox, select the Activate live access option.

A owopoe

To synchronize only the data related to some data entry periods, select the For selected data Entry Periods
option, then click the button next to this option to select the data entry periods of your choice.

o

In the Query Poll Interval field and drop-down menu of the Cache Settings groupbox, define what you want.
6. Click the Advanced button to define the other elements. This is optional.

Define the different elements.

5.2.4 Calculated Members

You can create a member containing an MDX formula for the following dimensions:

® The SSAS Measure dimension
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e Allthe merged dimensions
e All the standard dimensions

i Note

You can also use MDX scripts.

i Note

You can also import members that you have previously exported using the SAP BusinessObjects EPM
solutions, add-in for Microsoft Office. In the EPM add-in, these members are called "custom members".

You can choose not to display the calculated members in the retrieval tool, using the Visible option. The
calculations are performed but the members are not displayed.

You can enter comments to keep track of what issue the calculated members are designed to resolve: content,
etc.

You can also translate the names of calculated members in all available languages.

Example

To calculate the percentage of a product towards its parent in the Product hierarchy, we create a new measure
called "Percentage of a product towards its parent"”.

The formula syntax is as follows:
[Measures].[Consolidated AmountSales by product and geographical zone]/

([Product].[Productrollup].currentmember.parent,[Measures].[Consolidated AmountSales by product and
geographical zone]) * 100

Comments:

e [Consolidated AmountSales by product and geographical zone] is the measure containing the analyzing
data analyzed by the Product dimension.

e [Product].[Productrollup].currentmember.parent,[Measures].[Consolidated AmountSales by product and
geographical zone]: this means that we took the amount for the parent of the current member in the
Product hierarchy (called [Productrollup]) and for the measure [Consolidated AmountSales by product
and geographical zone].

This example applies if you are in multi-measure mode. If you were in single measure mode, the measure would
be 'Consolidated Amount'.

Related Information

Using your own MDX Scripts in a Deployment [page 79]

SAP Financial Consolidation Cube Designer User Guide
Cube Deployments PUBLIC 77



5.2.4.1 Creating Calculated Members

Procedure

1. Inthe tree structure part of the window, select the appropriate deployment.
2. Select the Calculated Members tab.

3. Click the New button.
The Calculated Member dialog box appears.

4. The Visible option is checked by default. If you do not want the calculated member to appear in the
retrieval tool, deselect the option.

5. Inthe Name field, enter the name you want.

6. Select the appropriate option: Measure, Merged Dimension or Dimension.

i Note
The Custom option enables you to use your own MDX scripts.

7. If you have selected Merged Dimension or Dimension, from the Dimension drop-down menu, select the
dimension for which you want to create the calculated member.

8. If you have selected a standard dimension, select a hierarchy from the Hierarchy drop-down menu.

i Note

A calculated member is always linked to a specific hierarchy. For a merged dimension and a Measure
dimension, the linked hierarchy is the default hierarchy, which you do not need to select.

i Note

The hierarchies that are available in the drop-down menu are the ones you selected in the Hierarchies
tab for the chosen dimension.

9. Click the button next to the Member field.
10. Select the member you want as the parent of the calculated member.

11. Inthe Expression area, enter or copy the MDX formula you want. Instead of manually entering the
members in the formula, you can select the members by clicking the Insert Member button.

12. In the Comment area, enter the text of your choice.
13. Click the OK button.

Related Information

Using your own MDX Scripts in a Deployment [page 79]
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5.2.4.2 Importing Calculated Members

Prerequisites

Using the EPM add-in, you have previously created "custom members" and exported them in a file.

Procedure

1. Inthe tree structure part of the window, select the appropriate deployment.
2. Select the Calculated Members tab.

3. Click the Import button.
The Calculated member import wizard opens.

4. Select the file containing the members you want to import using the File name button and click Next.

5. Select the members you want to import and click Next.
A summary describes which members are about to be imported.

6. Click Finish.

5.2.4.3 Translating Calculated Members

Procedure

1. Inthe tree structure part of the window, select the appropriate deployment.
2. Select the Translation tab.

3. Inthe Calculated Members area, enter the names in the available languages.

5.2.5 Using your own MDX Scripts in a Deployment

You can now use your own MDX scripts in cube designer. You can therefore link a script to a specific
deployment. The script will be deployed along with the cube each time you launch the deployment.

To do so, you must copy your MDX script and copy it in the Calculated Members tab in Financial Consolidation
Cube Designer. The script is saved as a custom calculated member.
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5.2.5.1 Linking your Script to a Deployment

Procedure

In your own tool, copy your MDX script.
In the tree structure part of the window in cube designer, select the appropriate deployment.
Select the Calculated Members tab.

Click the New button.
The Calculated Member dialog box appears.

A owop o

In the Name field, enter the name you want.

Select the Custom option.

In the Expression area, copy the MDX script.

In the Comment area, enter the text of your choice.
Click the OK button.

© 0 N o O

Results

You can translate the calculated member in the Translation tab.

5.2.6 SSAS Named Set Creation based on SAP Financial
Consolidation Characteristics and Filters

You can create SSAS Named sets from SAP Financial Consolidation characteristics, filters, or any manual
selection.

A Named set is a selection of dimension members that will be used as a flat list to create reports. It is the
equivalent of SAP Financial Consolidation filters.

e |[f creating a named set from characteristics, all dimension members associated to this characteristic value
will be added to the cube.

e |f creating a named set from filters, the complete filter will be retrieved.

® You can also enter an MDX formula that specifies the named set you want to create.

Provided that your data retrieval tool can retrieve named sets, you will be able to use the named sets in MDX
formulas or to select a set of dimension members.

You can translate the names of named sets in all available languages.
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5.2.6.1 Creating SSAS Named Sets

Procedure

1. Inthe tree structure part of the window, select the appropriate deployment.
2. Select the Named Sets tab.

3. Click the New button.
The Create Named Set dialog box appears.

4. Enter a name for the named set.

5. Select the option corresponding to the source you want to use for the named set: Use characteristic, Use
filter.

i Note

If you select the Supply MDX option, click the Next button, and simply enter the MDX formula that
specifies the named set in the Free MDX area.

Click the Next button.
From the Select dimension drop-down menu, select the dimension that you want to use for the named set.
Click the Next button.

From the Select Characteristic drop-down menu, select the characteristic or filter you want to use as part
of the named set.

10. Click the Next button.

11. In the Select Characteristic Member area, select the members you want to use to populate the named set.
12. Click the Next button.

13. Click the Finish button.

© w0 N O

5.2.6.2 Translating SSAS Named Sets

Procedure

1. Inthe tree structure part of the window, select the appropriate deployment.
2. Select the Translation tab.

3. Inthe Named Sets area, enter the names in the available languages.

5.2.7 SSAS Deployment Issue Resolution

Before deploying and processing a cube, you need to resolve the issues that are listed in the Issues To Resolve
tab. The tab only appears if there are issues and once you have resolved the issues, the tab no longer appears.

In the tab, you can double-click a row indicating an issue. The location where you must correct the issue is
automatically displayed.
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5.2.8 External Data Loading into an SSAS Cube

You can load data that are not stored in SAP Financial Consolidation directly into the cube.

A Caution

The SAP Financial Consolidation database server and the external table database server must be the same
type; Oracle and Oracle or SQL and SQL.

However, the following conditions must be respected:

® The table containing the external data must be defined by the user in cube designer.

e The dimension members must exist in SAP Financial Consolidation database so that the proper security
applies.

e The data table must follow a specific format to be compatible.

You can load data into existing SAP Financial Consolidation dimension members but no new dimensions or
members can be created.

You must select in the cube designer view, the right dimensions and dimension members (based on the data
that you want to import) and measures for both analyzing dimensions and data level (package/ consolidated
data). For example, if the measure corresponding to an analysis (for example, by product) is not selected in the
cube designer view and if the external table already contains data analyzed by product, the data will not be
available in the cube deployed from this view.

! Restriction

If the Reporting Category dimension exists in a view, the external table from which you want to load data
must be in the SAP Financial Consolidation database.

Related Information

Reporting Category Dimension Creation [page 39]

5.2.8.1 Dimension Members

Only a specific format for data tables is supported by cube designer. This table should contain the identifiers of
the SAP Financial Consolidation members for each dimension (one column by dimension in the table).

As opposed to the SAP Financial Consolidation and Carat fact tables, all dimensions must be available in the
external tables, especially the Category + Data Entry period dimensions (for package data) + scope, variant
and consolidation currency (for consolidated data).

For these missing dimensions, the system requires that their columns are named as follows:

e (Category
® Scope
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e \Variant
e Conscurrency
e DEPeriod

As far as other dimensions are concerned, the names of the colums are the same as in SAP Financial
Consolidation fact tables.

5.2.8.2 Amounts

The external table should contain one or several columns dedicated to containing data: one column named
‘amount' (for package data), another column named 'convamount' for converted data, another column named
'consamount' for consolidated data. If the SSAS 2005 cube is based on package data (defined in the view from
which it has been deployed), only the first column (amount) will be taken into account in the deployment. If the
SSAS 2005 cube is based on consolidated data (defined in the view), the columns amount, converted amount
and consolidated amount could be taken into account during the deployment step (depending on the
measures selected in the view).

5.2.8.3 Server Selection and Server Information Entry

In order to load external data into a cube, you need to select the server and specify some server information.
This is the server containing the tables you want to load.

A Caution
The SAP Financial Consolidation database server and the external table database server must be the same
type; Oracle and Oracle or SQL and SQL.
The Microsoft Data Link Properties dialog box enables you to specify the required information. This dialog box
contains four tabs: Provider, Connection, Advanced and All.
The Provider tab enables you to specify if the tables are SQL or Oracle tables.

The Connection, Advanced and All tabs are contextual and depend on the type of provider (SQL or Oracle)
selected in the Provider tab.

Related Information

Star Schema Deployment Creation [page 108]
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5.2.8.4 Loading External Data into a Cube

Procedure

1. Inthe tree structure part of the window, select the appropriate deployment.
2. Select the Custom Fact Tables tab.

3. Click the New button.
The Custom Fact Table dialog box appears.

4. Click the _4*| button in the Data Source area.
The Data Link Properties dialog box appears, displaying the Connection tab.

5. Inthe Connection tab, specify the required information.
6. You must ensure that the Allow saving password option is selected.

Click on Test Connection.
A message appears, indicating whether the connection is valid or not.

8. If the connection is valid, click on OK.
The Data Link Properties dialog box reappears.

9. Click on OK.
The server information is displayed in the Data Source area.

10. In the Table Name area, enter the table name as it will appear in cube designer.
11. Leave Default in the Measure Group drop-down menu.
12. Click on OK.

5.2.9 SSAS Cube Deployment and Processing

Deploying a cube consists of creating a cube's structure.
Processing a cube consists of loading data in a cube.

When a cube is deployed, it is automatically processed. You can also choose to re-process only an existing cube
or only one or several parts of the cube, that is packages or consolidations (depending on the data level of the
view), or specific dimensions.

Before deploying a cube, the Deployment tab enables you to view all of the information that will be taken into
account in the cube. This tab displays:

e All of the dimensions defined in the view.
e All SAP Financial Consolidation packages or consolidations selected (depending on the data level of the
view). These are indicated by a yellow cube.

In the Action colum:

e |f nothing is displayed for a specific dimension or member row, this means that the dimension or member
was excluded or had never been included in the view and therefore will not be exported.

e The following information may appear:

o Add: if the corresponding dimension or member was excluded in the last deployment but is now being
included.
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o Update: if the corresponding dimension or member was included in the last deployment and is again
being included.

o Remove: if the corresponding dimension or member was included in the last deployment but is now
being excluded.

i Note

When clicking the Deployment tab, an error can occur if the timeout has been reached (if there is a large
number of consolidation). To increase the timeout, you can change the WebClientTimeout key value in the
Designer Cartesis.InformationDelivery.Workbench.exe.config file.

While deploying and processing a cube, you can follow the steps in the bottom part of the window.
If this part does not appear, select View > Deployment Log .
You can perform the following actions on the log:

e Display or hide one or more types of information by clicking the Errors, Warnings and/or Messages buttons.
o Errors: Errors cause the deployment and processing to fail.

o Warnings: Warnings are indicated but do not prevent you from deploying and processing the cube
successfully.

o Messages: Messages indicate each step of the deployment and processing (for example, "Starting to
build the cube").
e Delete the log by clicking the Clear List button.
e Export the log in .csv format, by clicking the Export List button.

i Note

If there are duplicated members, a pop-up message will appear while deploying the cube, indicating the
remaining duplicated members and asking you whether you want to continue or stop the deployment.

A Caution

Before deploying and processing a cube, you need to resolve any remaining issues. |If some issues are
unresolved, the Issues to Resolve tab appears and the Deploy button is not accessible.

You can also deploy or process a cube without using the cube designer interface.

Related Information

Member Name for Standard Dimensions [page 41]
SSAS Deployment Issue Resolution [page 81]
Deploy, Re-Process and Update Actions [page 117]
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5.2.9.1 Deploying an SSAS Cube

Procedure

In the Deployment tab, click the Deploy button.
i Note

The cube will also be processed.

i Note

From the Deployment tab, you can see the dates of the latest consolidation executions in the column Latest
database data update by clicking the button Source Data Date. You can therefore compare the deployment
date and the consolidation execution date.

i Note

The date of the deployment will appear in the Last Deployed On field of the General tab.

5.2.9.2 Processing an SSAS Cube

Procedure

In the Deployment tab, click the Re-Process button.

i Note

The date of the re-process will appear in the Last Processed On field of the General tab.

5.2.9.3 Processing only Parts of an SSAS Cube

Context

If you do not want to re-process the whole cube, you can choose to re-process some parts of the cube, that is
packages or consolidations (depending on the data level of the view), or specific dimensions, that are indicated
by a yellow cube in the Deployment tab, or dimensions.
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Procedure

1. Inthe Selected column of the Deployment tab, select the checkboxes of the parts you want to process.
2. Click the Re-Process Selected button.

i Note

The date of the re-process will appear in the Last Processed On field of the General tab.

5.2.10 SSAS Deployment Update

You can update a deployment.

The following items will be updated:

e (Calculated members.

e Named sets.

® |ive access settings.

e |f not up-to-date, the UDF for security component is also updated.

Related Information

Calculated Members [page 76]
SSAS Named Set Creation based on SAP Financial Consolidation Characteristics and Filters [page 80]
Database and Cube Data Synchronization [page 74]

5.2.10.1 Updating an SSAS Deployment

Procedure

In the Deployment tab, click the Update button.

5.2.11 Remove an SSAS Cube

You can remove a cube from cube designer.

In SSAS management tools, the cube, its dimensions, its corresponding data source and data source view are
deleted.
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5.2.11.1 Removing an SSAS Cube

Procedure

1. Inthe Deployment tab, click the Remove Cube button.
A confirmation message appears.

2. Click the Yes button.

5.2.12 Remove an SSAS Database

You can remove a database from cube designer.

In this case, the database is deleted along with all its cubes.

5.2.12.1 Removing an SSAS Database

Procedure

1. Inthe Deployment tab, click the Remove Database button.
A confirmation message appears.

2. Click the Yes button.

5.3 SAP NetWeaver Business Warehouse Cube
Deployments

You will now create a SAP NetWeaver Business Warehouse (SAP NetWeaver BW) cube deployment.
Once a deployment has been created, you will carry out the following steps:

e Enter deployment and cube information

® Resolve issues

® | oad external datainto a cube

e Define the organization of SAP NetWeaver BW dimensions and characteristics
® Deploy and process a cube

e Copy adeployment

® Rename a deployment

SAP BusinessObjects tools that support SAP NetWeaver BW cubes - for example: SAP Business Explorer (SAP
BEXx) tools, SAP BusinessObjects Interactive Analysis, and SAP BusinessObjects EPM solutions, add-in for
Microsoft Office - will be able to analyze the data of these cubes.
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| Restriction

e |fan SAP NetWeaver BW cube has already been deployed from a cube designer view and BEx reports
have been designed on top of this cube, these reports cannot be used again on top of a new SAP
NetWeaver BW cube that will be deployed from the same view. This limitation does not exist for the
EPM add-in reports.

e |nan SAP BEx report, you can analyze the same metadata coming from several SAP NetWeaver BW
cubes. However, in this particular case, you cannot browse a cube that has been generated with cube
designer for the following reason: the SAP Financial Consolidation codes are not stored in the
dimension member keys of the SAP NetWeaver BW cube generated with cube designer.

e SAP NetWeaver BW deployments do not support SAP Financial Consolidation data security.

e Additional descriptions for dimension members are not exported into SAP NetWeaver BW cubes. Only
SAP Financial Consolidation code and short descriptions are always exported.

5.3.1 SAP NetWeaver Business Warehouse Deployment
Creation

Creating an SAP NetWeaver Business Warehouse (SAP NetWeaver BW) deployment consists of the following
main steps:

e FEntering a name for the deployment.
e Entering the user name and password to SAP NetWeaver BW.

5.3.11 Creating an SAP NetWeaver Business Warehouse
Deployment

Prerequisites

Your administrator must provide you with the user name and password to SAP NetWeaver Business Warehouse
(SAP NetWeaver BW) that you need to enter when creating the deployment.

Procedure

1. Inthe tree structure of the main window, right-click on Deployments, then select Add Deployment.
The New Deployment dialog box opens.

2. Inthe Deployment Name field, enter the name you want to give to the deployment.

3. Inthe Server Type area, select NetWeaver BW.

i Note

In the Server Details area, the fields Application Server, System Number and Client are filled in by
default with information from the Central Management Console.
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4. Inthe User and Password fields, enter the user name and password provided by your administrator.

i Note

The Deployer Service Url field is filled in by default. The URL comes from the
Cartesis.InformationDeliveryWorkbench.exe.config file, which is located in the cube designer
installation directory. You can change the URL. It will be effective for the current deployment.

i Note

If you change the URL in the file, it will be applied to all deployments.

5. If the Financial Consolidation database is hosted on a SAP HANA server and provided that you have
defined the view with the deployment type SAP BW, the HANA Server and Port (hosting Financial
Consolidation Database) area is displayed. Enter the name and the port for the SAP HANA server that
hosts the Financial Consolidation database.

6. Click OK.

5.3.2 SAP NetWeaver Business Warehouse Deployment and
Cube Information

Carry out the following steps:

e Choose the SAP NetWeaver Business Warehouse (SAP NetWeaver BW) InfoArea. The SAP NetWeaver BW
InfoArea server has automatically been specified while creating the deployment and is displayed in the
General tab.

e By default, all packages or consolidations (depending on the data level of the view) are deployed in one
single InfoCube. However, you can choose to deploy one InfoCube per package or consolidation by
deselecting the Deploy in a single infocube option.

e (Choose the name of the future cube.

e |f more than one language is available, select the language you want for the dimension and hierarchy
names.

i Note

As a reminder, the languages you want to make available in the future cube have been chosen in the
view and appear available in the Options tab of the deployment (the languages that have not been
selected in the view are greyed out). Only the language you select will be available in the cube for
dimension and hierarchy names.

i Note

Member names will appear in the cube in all the languages that have been selected for the view.
However, if the language of the retrieval tool you use is not available in the SAP NetWeaver BW cube,
internal IDs will appear as names for the members.

You can define all of the above elements in the Options tab of a deployment.
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Related Information

Language Selection [page 23]
SAP NetWeaver Business Warehouse Cube Deployment and Processing [page 97]

5.3.3 Cube Deployment based on Another Cube for Transport
Purposes

If you want to perform a transport, you must first, in Designer, enable the deployment of an SAP NetWeaver Bl
cube in the target system, based on a cube existing in the source system (for example, in your production
system, you want to deploy a cube that is based on a cube that already exists in your test system). This way,
the cube uses the technical names of the cube in the source system and the reports based on technical names
will continue to work in the target system. Then, in SAP NetWeaver, you can transport the BEx queries and their
objects.

Follow these steps:

1. Inthe source system, deploy a cube.
2. Inthe target system, create a new deployment.

3. Inthe Options tab of the new deployment, select the option Deploy cube based on another cube and enter
the server information of the source system. Select the InfoArea, then select the name of the cube you
have deployed in the source system and on which you want to base the cube in the target system.

4. Deploy the cube in the target system.
5. In SAP NetWeaver BW, transport the BEx queries and all the objects created by the queries. For more

information, refer to the SAP NetWeaver BW guide.
A Caution

When you decide to perform the cube deployment based on the source cube, the two systems must be
identical.

5.3.4 SAP NetWeaver Business Intelligence Deployment
Issue Resolution

Before deploying and processing a cube, you need to resolve the issues that are listed in the Issues To Resolve
tab. The tab only appears if there are issues and once you have resolved the issues, the tab no longer appears.

In the tab, you can double-click a row indicating an issue. The location where you must correct the issue is
automatically displayed.
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5.3.5 External Data Loading into an SAP NetWeaver Business
Warehouse Cube

You can load data that are not stored in SAP Financial Consolidation directly into the cube.

A\ Caution

The external table from which you want to load data must be in the SAP Financial Consolidation database.

However, the following conditions must be respected:

® The table containing the external data must be defined by the user in cube designer.
e The dimension members must exist in SAP Financial Consolidation database.
® The data table must follow a specific format to be compatible.

You can load data into existing SAP Financial Consolidation dimension members but no new dimensions or
members can be created.

You must select in the cube designer view, the right dimensions and dimension members (based on the data
that you want to import) and measures for both analyzing dimensions and data level (package/ consolidated
data). For example, if the measure corresponding to an analysis (for example, by product) is not selected in the
cube designer view and if the external table already contains data analyzed by product, the data will not be
available in the cube deployed from this view.

Related Information

Reporting Category Dimension Creation [page 39]

5.3.5.1 Dimension Members

Only a specific format for data tables is supported by cube designer. This table should contain the identifiers of
the SAP Financial Consolidation members for each dimension (one column by dimension in the table).

As opposed to the SAP Financial Consolidation and Carat fact tables, all dimensions must be available in the
external tables, especially the Category + Data Entry period dimensions (for package data) + scope, variant
and consolidation currency (for consolidated data).

For these missing dimensions, the system requires that their columns are named as follows:

e (Category

e Scope

e \Variant

e (Conscurrency
e DEPeriod

As far as other dimensions are concerned, the names of the colums are the same as in SAP Financial
Consolidation fact tables.
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5.3.5.2 Amounts

The external table should contain one or several columns dedicated to containing data: one column named
‘amount' (for package data), another column named 'convamount' for converted data, another column named
'‘consamount' for consolidated data. If the cube is based on package data (defined in the view from which it has
been deployed), only the first column (amount) will be taken into account in the deployment. If the cube is
based on consolidated data (defined in the view), the columns amount, converted amount and consolidated
amount could be taken into account during the deployment step (depending on the measures selected in the
view).

5.3.5.3 Server Selection and Server Information Entry

In order to load external data into a cube, you need to select the server and specify some server information.
This is the server containing the tables you want to load.

A\ Caution

The SAP Financial Consolidation database server and the external table database server must be the same
type; Oracle and Oracle or SQL and SQL.

The Microsoft Data Link Properties dialog box enables you to specify the required information. This dialog box
contains four tabs: Provider, Connection, Advanced and All.
The Provider tab enables you to specify if the tables are SQL or Oracle tables.

The Connection, Advanced and All tabs are contextual and depend on the type of provider (SQL or Oracle)
selected in the Provider tab.
Related Information

Star Schema Deployment Creation [page 108]

5.3.5.4 Loading External Data into the SAP NetWeaver
Business Warehouse Cube

Procedure

1. Inthe tree structure part of the window, select the appropriate deployment.
2. Select the Custom Fact Tables tab.

3. Click the New button.
The Custom Fact Table dialog box appears.

SAP Financial Consolidation Cube Designer User Guide
Cube Deployments PUBLIC 93



Click the il button in the Data Source area.
The Data Link Properties dialog box appears, displaying the Connection tab.

5. Inthe Connection tab, specify the required information.

6. You must ensure that the Allow saving password option is selected.

Click on Test Connection.
A message appears, indicating whether the connection is valid or not.

If the connection is valid, click on OK.
The Data Link Properties dialog box reappears.

Click on OK.
The server information is displayed in the Data Source area.

10. In the Table Name area, enter the table name as it will appear in cube designer.

11. Leave Default in the Measure Group drop-down menu.
12. Click on OK.

5.3.6 SAP NetWeaver Business Warehouse Dimensions and

Characteristics Organization

All the SAP Financial Consolidation dimensions included in the view are automatically taken into account in the
cube deployment. You can add or remove SAP Financial Consolidation dimensions in the future cube by
including or excluding them in the view.

All the SAP Financial Consolidation dimensions are considered as SAP NetWeaver Business Warehouse
(SAP NetWeaver BW) characteristics.

These characteristics are grouped together in what are called SAP NetWeaver BW dimensions to ease the
data retrieval in the data retrieval tool you will then use.

In the InfoCube Dimensions tab, two organizations of SAP NetWeaver BW characteristics grouped together in
SAP NetWeaver BW dimensions are displayed:

94

On the left side, the current organization displayed is the one applied to the InfoCube after the latest
deployment you have performed. You can modify this presentation at your convenience.

On the right side, the organization displayed is the one that is the most optimized for volume. You cannot
modify this presentation. To apply this organization to the next deployment, use the Reset feature.
i Note

We strongly recommend that you apply the optimized organization to the InfoCube to be deployed,
especially if the large-volume consolidation tables are used. This organization is designed to enhance
the deployment creation and update time.

i Note

If you have not performed any deployment before support package 15, the organizations displayed on
both sides are identical.
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About the Optimized Organization

Merged Dimensions. This dimension contains all merged characteristics available in the view, including the
Reporting Category characteristic.

Consolidation Dimensions. This dimension contains Category, Data Entry Period, Scope, Variant and
Consolidation Currency if they are not used in a merged SAP Financial Consolidation dimension, excluded
from the view or not available due to the view data source level, meaning package or consolidated data.
The large-volume dimensions are each defined as a unique characteristic in a dimension that has the same
name.

i Note

any time there is one characteristic for one dimension, the dimension is automatically set as a "line
item dimension" in BW after performing a deployment. This enhances the deployment time.

The Analysis Dimensions contains as characteristics all the remaining dimensions that have a lower
volume.

About the Current Organization

You can perform the following actions:

Move a characteristic to a lower or upper dimension.
Create a dimension.

Rename a dimension.

Delete a dimension.

Reset to the optimized organization.

5.3.6.1 Choosing the SAP NetWeaver Business Warehouse

Dimensions and Characteristics Organization

Context

You can choose between two organizations to apply to the InfoCube to be deployed.

i Note

We strongly recommend that you apply the optimized organization to the InfoCube to be deployed,
especially if the large-volume consolidation tables are used. This organization is designed to enhance the
deployment creation and update time.
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Procedure

In the InfoCube Dimensions tab, do one of the following:

o To apply the current organization displayed on the left side, you do not need to do anything specific.
However, you can modify the organization as needed.

o To apply the optimized organization displayed on the right side, click Reset. The organization displayed on
the right is copied to the left side. You cannot modify this organization.

5.3.6.2 Moving an SAP NetWeaver Business Warehouse
Characteristic to a Lower or Upper Dimension

Context

You are using the current organization displayed on the left side of the InfoCube Dimensions tab.

Procedure

1. Inthe InfoCube Dimensions tab of the deployment, select the characteristic you want to move.
2. Do one of the following:

o To move the characteristic to the upper dimension, click the up arrow.
o To move the characteristic to the lower dimension, click the down arrow.

5.3.6.3 Creating an SAP NetWeaver Business Warehouse
Dimension

Context

You are using the current organization displayed on the left side of the InfoCube Dimensions tab.

Procedure

1. Inthe InfoCube Dimensions tab of the deployment, click the Folder icon.
New Dimension appears in the tree structure.

2. Right-click on New Dimension and select Rename.
New Dimension is highlighted.
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3. Enteraname.

5.3.6.4 Renaming an SAP NetWeaver Business Warehouse
Dimension

Context

You are using the current organization displayed on the left side of the InfoCube Dimensions tab.

Procedure

1. Inthe InfoCube Dimensions tab of the deployment, right-click on the dimension you want to rename, then
select Rename.

2. Enter the name you want.

5.3.6.5 Deleting an SAP NetWeaver Business Warehouse
Dimension

Context

You are using the current organization displayed on the left side of the InfoCube Dimensions tab.

Procedure

1. Inthe InfoCube Dimensions tab of the deployment, select the dimension you want to remove.

2. Click the cross button.
If characteristics were grouped together in the deleted dimension, they are automatically moved to the
lower dimension.

5.3.7 SAP NetWeaver Business Warehouse Cube Deployment
and Processing

Deploying a cube consists of creating a cube's structure.

When a cube is deployed, it is automatically processed, that is data are loaded to the cube.
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Once you have deployed a cube a first time, each time you will then deploy the same cube, the behavior is as
follows:

e |f new dimensions, members, or hierarchies are added to the view, only these new dimensions, members
or hierarchies are deployed and added to the cube.

e \When dimensions are added to the view, if you want data to be consequently updated in the cube, you
must then re-process the parts of the cube that use the included dimensions.

e |f you have excluded dimensions from the view, when asking for a deploy, a message warns you that all
data in the cube will be removed and re-loaded. Note that this operation can take a long time.

By default, all packages or consolidations (depending on the data level of the view) are deployed in one single
InfoCube: the Deploy in a single infocube option is selected by default in the Options tab. The deployment name
that will be displayed in the Deployment tab, concatenates the name of the InfoArea and the name of the cube
that are entered in the Options tab.

However, you can choose to deploy one InfoCube per package or consolidation by deselecting the Deploy in a
single infocube option.

You can re-process some parts of the cube, meaning packages or consolidations (depending on the data level
of the view), or specific dimensions (using the Re-process selected button).

You can re-deploy a cube. The cube is completely re-created with the same technical names, so that the BEx
queries continue to function.

i Note

If you deploy a cube several times, respectively including, excluding and including again a standard
dimension or a merged dimension:

e at the second deployment, a message indicates that technical name of the dimension has been
changed and you must update the corresponding BEx query.

e if you do not update the BEx query, at the third deployment, the technical name of the dimension has
been changed between the first and the third deployments and no message warns you to update the
BEx query.

| Restriction

Inan SAP BEx report, you can analyze the same metadata coming from several SAP NetWeaver BW cubes.
However, in this particular case, you cannot browse a cube that has been generated with cube designer for
the following reason: the SAP Financial Consolidation codes are not stored in the dimension member keys
of the SAP NetWeaver BW cube generated with cube designer.

i Note

When a view contains several SAP NetWeaver BW deployments, do not deploy more than one cube if they
are to be deployed on the same SAP NetWeaver BW server.

Before deploying a cube, the Deployment tab enables you to view all of the information that will be taken into
account in the cube. This tab displays:

e All of the dimensions defined in the view.

e All SAP Financial Consolidation packages or consolidations selected (depending on the data level of the
view). These are indicated by a yellow cube.

In the Action colum:
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e |f nothing is displayed for a specific dimension or member row, this means that the dimension or member
was excluded or had never been included in the view and therefore will not be exported.

e The following information may appear:

o Add: if the corresponding dimension or member was excluded in the last deployment but is now being
included.

o Update: if the corresponding dimension or member was included in the last deployment and is again
being included.

o Remove: if the corresponding dimension or member was included in the last deployment but is now
being excluded.

i Note

When clicking the Deployment tab, an error can occur if the timeout has been reached (if there is a large
number of consolidation). To increase the timeout, you can change the WebClientTimeout key value in the
Designer Cartesis.InformationDelivery Workbench.exe.config file.

While deploying and processing a cube, you can follow the steps in the bottom part of the window.
If this part does not appear, select View > Deployment Log.
You can perform the following actions on the log:

e Display or hide one or more types of information by clicking the Errors, Warnings or Messages buttons.
o Errors: Errors cause the deployment and processing to fail.

o Warnings: Warnings are indicated but do not prevent you from deploying and processing the cube
successfully.

o Messages: Messages indicate each step of the deployment and processing (for example, "Starting to
build the cube").

e Delete the log by clicking the Clear List button.
e Export the log in .csv format, by clicking the Export List button.

i Note

If there are duplicated members, a pop-up message will appear while deploying the cube, indicating the
remaining duplicated members and asking you whether you want to continue or stop the deployment.

A Caution

Before deploying and processing a cube, you need to resolve any remaining issues. If some issues are
unresolved, the Issues to Resolve tab appears and the Deploy button is not accessible.

You can also deploy or process a cube without using the Financial Consolidation Cube Designer interface.

Related Information

Member Name for Standard Dimensions [page 41]
SSAS Deployment Issue Resolution [page 81]
Deploy, Re-Process and Update Actions [page 117]
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5.3.71 Deploying an SAP NetWeaver Business Warehouse
Cube

Procedure

In the Deployment tab, click the Deploy button.

i Note

The cube will also be processed.

i Note

From the Deployment tab, you can see the dates of the latest consolidation executions in the column Latest
database data update by clicking the button Source Data Date. You can therefore compare the deployment
date and the consolidation execution date.

5.3.7.2 Processing only Parts of an SAP NetWeaver
Business Warehouse Cube

Context

If you do not want to re-process the whole cube, you can choose to re-process some parts of the cube, meaning
packages or consolidations (depending on the data level of the view), or dimensions, that are indicated by a
yellow cube in the Deployment tab, or dimensions.

i Note

If you have selected the Deploy in a single infocube option in the Options tab of the deployment, the Re-
Process button is not available.

Procedure

1. Inthe Selected column of the Deployment tab, select the checkboxes of the parts you want to process.
2. Click the Re-Process Selected button.
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5.3.8 Deploying only Most Detailed Data in an SAP
NetWeaver Business Warehouse Cube

Some data are not relevant for SAP NetWeaver BW cubes. If non detailed and detailed data are included in a
cube, some amounts appear twice.

So that amounts do not appear twice, you can ask to include only most detailed data in a BW cube, using the
Dimensional Analysis tab of a BW deployment.

The Financial Consolidation category builder's existing dimensional analysis are read, then:

e |fthe data are all detailed with the same level of detail, you can select the Include only most detailed data
for account flow/member option. The most detailed data for each account/flow are included and the other
data are not included.

e |f the data are detailed with different levels of detail, then, you can additionaly select one or more of the
following dimensions: Reporting Unit, Audit ID, Origin Unit. For example, the most detailed data for each
account/flow/reporting unit are included and the other data are not included.

Example

By default, all the amounts below are included in the BW cube. For U1, the detailed and the non detailed data
both appear: 50+20+30.

Account Flow Reporting Unit Product Amount
Sales F99 ul - 50
Sales F99 Ul P1 20
Sales F99 Ul p2 30
Sales F99 U2 - 25

So that only the most detailed data appear for U1 (20+30), check the Include only most detailed data for
account flow/member option: the most detailed data for each account/flow are included in the cube, the other
amounts are ignored. However, since the data are detailed with different levels of detail, no data is included for
u2.

Account Flow Reporting Unit Product Amount
Sales F99 Ul

Sales F99 ul P1 20
Sales F99 U1 P2 30
Sales F99 U2

So that data for U2 is also included in the cube, check also the Reporting Unit option. The most detailed
amounts are included in the cube for each account/flow/reporting unit.

Account Flow Reporting Unit Product Amount

Sales F99 Ul
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Account Flow Reporting Unit Product Amount

Sales F99 ul P1 20
Sales Fo9 Ul P2 30
Sales F99 u2 - 25

5.3.9 Initialize a NetWeaver Business Warehouse Deployment

Once a cube has already been deployed, you can initialize the cube. The cube is deleted and completely re-
created. To do so, click Initialize.

i Note

If an SAP NetWeaver Business Warehouse (SAP NetWeaver BW) cube has already been deployed from a
cube designer view and BEx reports have been designed on top of this cube, these reports cannot be used
again on top of a new SAP NetWeaver BW cube that will be initialized from the same view. This limitation
does not exist for reports created with the EPM add-in for Microsoft Office.

5.3.10 Remove an SAP NetWeaver Business Warehouse Cube

You can remove a cube from cube designer.

In SAP NetWeaver Business Warehouse (SAP NetWeaver BW), all the cube elements are deleted.

5.3.10.1 Removing an SAP NetWeaver Business Warehouse
Cube

Procedure

1. Inthe Deployment tab, click Remove Cube.
A confirmation message appears.

2. Click Yes.

5.3.11 Remove an SAP NetWeaver Business Warehouse
InfoArea

You can remove an InfoArea from cube designer.

In this case, the InfoArea is deleted along with all its cubes.
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5.3.11.1 Removing an InfoArea

Procedure

1. Inthe Deployment tab, click Remove InfoArea.
A confirmation message appears.

2. Click Yes.

5.4 SAP HANA Deployments

You will now create a SAP HANA deployment.
Once a deployment has been created, you will carry out the following steps:

® Deploy the analytic view.
e Copy adeployment.
® Rename a deployment.

SAP BusinessObjects tools that support SAP HANA analytic views will be able to analyze the data of these
views.

SAP HANA Transport - Not Supported

You cannot use the SAP HANA transport feature for the modeling views created by cube designer, because
cube designer creates additional objects that simply cannot be transported.

As a workaround, you can export the solutions and import them in another system. For more information on
how to export and import solutions, see Solution Export and Import [page 17].

5.4.1 SAP HANA Deployment

Performing a SAP HANA deployment consists of creating the following SAP HANA modeling views:

® An analytic view. The analytic view is defined on the fact table containing Financial Consolidation data
along with the created attribute views.
e Attribute views. One attribute view is created per dimension included in the cube designer view.

Also, the following security objects are deployed:

e Roles. ASAP HANA role is created for each Financial Consolidation data access group.
® Privileges. A SAP HANA privilege is created for each category that is selected for a Financial Consolidation
data access group.
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e Stored procedures. A SAP HANA stored procedure is created for each filter defined on a Financial
Consolidation data access group.

When performing a deployment, the security settings specified in Financial Consolidation are applied to the
HANA modeling views and objects created. The security updates (a data access group modification for
example) are automatically taken into account in the HANA modeling views and objects.

i Note

A SAP HANA deployment can only be performed to the same SAP HANA instance as Financial
Consolidation.

Before deploying SAP HANA modeling views, the Deployment tab enables you to view all of the information that
will be taken into account in the modeling views. This tab displays all of the dimensions defined in the designer
view. You can then click Deploy to launch the deployment.

i Note

When clicking the Deployment tab, an error can occur if the timeout has been reached (if there is a large
number of consolidation). To increase the timeout, you can change the WebClientTimeout key value in the
Designer Cartesis.InformationDelivery.Workbench.exe.config file.

Deploying Modeling Views only (not Security Objects)

Once you have performed a first deployment, which includes the deployment of both SAP HANA modeling
views and security objects, you then do not need to re-deploy the security objects as the security updates
performed in Financial Consolidation are automatically taken into account in SAP HANA. Also, as deploying
security objects can take quite some time, you can choose to deploy only the SAP HANA modeling views and
not the security objects.

For example, you can choose to deploy only the modeling views in the following cases:

e You are still working on the modeling phase and you do not need to apply the security to the data.

® You have already performed a first deployment (including the deployment of both modeling views and
security objects) and you have added a new hierarchy.

To launch the deployment of modeling views only, click Deploy modeling views only.

Redeployment

Once you have performed a SAP HANA deployment a first time, each time you will then deploy the same
deployment, the SAP HANA modeling views are updated with the new or removed dimensions and hierarchies.

You can re-deploy SAP HANA modeling views as much as needed.

Redeploying is necessary when changes have been made in the cube designer view (adding or excluding a
dimension for example) so that the changes are updated in the SAP HANA modeling views.
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i Note

You do not need to perform a re-deploy when security objects have been updated in Financial Consolidation
because they are automatically updated in SAP HANA.

Errors, Warnings and Deployment Log

Both errors and warnings do not generally stop the SAP HANA deployment process. For example, if a
dimension cannot be created, the creation step is skipped and the process goes on, creating the next
dimensions. However, if there is an intangible error, that is a SAP HANA error that stops the process, all the
SAP HANA objects that have previously been generated are kept.

While deploying SAP HANA modeling views and objects, you can follow the steps in the bottom part of the
window.

If this part does not appear, select |# View » Deployment Log 3.

You can perform the following actions on the log:

e Display or hide one or more types of information by clicking the Errors, Warnings or Messages buttons.
o Errors: Errors cause the deployment and processing to fail.
o Warnings: Warnings are indicated but do not prevent you from deploying the SAP HANA modeling
views successfully.
o Messages

e Delete the log by clicking the Clear List button. : Messages indicate each step of the deployment and
processing (for example, "Starting to build...").

e FExportthelogin .csv format, by clicking the Export List button.

5.4.2 Creating a SAP HANA Deployment

Procedure

1. Inthe tree structure of the main window, right-click on Deployments, then select Add Deployment.
The New Deployment dialog box opens.

2. Inthe Deployment Name field, enter the name you want to give to the deployment. This name is also given
to the resulting SAP HANA analytic view.

i Note

The following areas are already filled in: Server TypeFinancial Consolidation Schema Name, , HANA
Content Technical User and HANA Content URL.

3. Click OK.
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5.4.3 Remove the Modeling Views from SAP HANA

When a solution, a view or a deployment is removed from cube designer, the SAP HANA analytic view is not
removed and the security objects are updated.

You can remove them by clicking Remove modeling views in the Deployment tab.

5.5 Deployment Copy

You can copy and paste a deployment in a view.

Once you have copied a deployment, you can rename it.

Related Information

Renaming a Deployment [page 106]

5.5.1 Copying and Pasting a Deployment

Procedure

1. Inthe tree structure part of the window, right-click on the deployment you want to copy and select Copy.

2. Right-click on the Deployments node and select Paste.

5.6 Renaming a Deployment

Procedure

1. Inthe tree structure part of the window, right-click on the deployment you want to rename and select
Rename.
The name of the deployment appears highlighted.

2. Enter the new name.
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5.7 Deployments Audit

You can now display the list of all the deployments performed in all cube designer solutions linked to the
current SAP Financial Consolidation data source. From this list, you can delete deployments' information from
the SAP Financial Consolidation database tables that are not used anymore. The following information is
available:

® The name of the deployment.

® The time at which the deployment was last saved (date and hour).

5.7.1 Auditing Deployments
Procedure

1. Select|p File » Deployment Audit 3.
The Deployment Audit dialog box appears.

2. Todisplay all the list of deployments, click the Get Deployments button.
3. Select the checkboxes of the deployments you want to delete.

4. Click the Delete Selected Deployments button.
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6 Star Schema Deployments

6.1 Introduction to Star Schemas

You can generate either an SQL or an Oracle star schema.
A star schema contains three types of tables:

e Facttables. These are tables that contain data.

e Dimension tables. One table is created for each dimension.

e Characteristic tables. One table is created for each "standard" characteristic. Only characterictics that
have been selected in the view are taken into account.
However, characteristic tables are not created for characteristics that are linked to a dimension in the same
reference table. For each of these characteristics, a column is created in the dimension table.

Tables can contain unicode characters. However, we recommend that you use ANSI characters and no
accented characters for the table names.

Besides, a star schema:

e Does not support hierarchies.
e Does not support SAP Financial Consolidation data security.
® Supports SAP Financial Consolidation comments (as opposed to OLAP cubes).

6.2 Star Schema Deployment Creation

Creating a star schema deployment consists of the following main steps:

® Entering a name for the deployment.
e Selecting the server and specifying the server information. This is the server on which the star schema will
be generated.

The Microsoft Data Link Properties dialog box enables you to specify the required information. This dialog box
contains four tabs: Provider, Connection, Advanced and All.

The Provider tab enables you to specify if you want to generate an SQL or Oracle star schema.

The Connection, Advanced and All tabs are contextual and depend on the type of provider (SQL or Oracle)
selected in the Provider tab.
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6.2.1 Creating a Star Schema Deployment

Procedure

In the tree structure pane of the main window, right-click on Deployments and select Add Deployment.
The New Deployment dialog box opens.

In the Server Type groupbox, select the Star Schema option.

The Data Link Properties dialog box will appear, displaying the Connection tab.

In the Connection tab, specify the required information. For more information regarding SQL or Oracle
providers, please refer to the paragraphs describing the tab.

4. You must ensure that the Allow saving password option is selected.

5. Click on Test Connection.
A message appears, indicating whether the connection is valid or not. To find out more about this button,
please refer to the paragraphs above describing the tab.
6. If the connectionis valid, click on OK.
The Data Link Properties dialog box reappears.
7. Click on OK.
The New deployment dialog box reappears. A default star schema deployment name is displayed in the
Deployment Name field and the server information is displayed in the Server Details groupbox.
i Note
If you want to modify server information, click on Change. The Data Link Properties dialog box will
appear.
8. Enter the name you want to give the star schema deployment.
9. Clickon OK.

The deployment appears below Deployments in the tree structure pane. If you click on it, the deployment
will appear in the right pane of the window, displaying three tabs: General, Star Schema Options and
Deployment. In the General tab, you can view the server connection information and modify it using the
Change Connection button.

6.2.2 Provider Tab

This tab enables you to specify the OLE DB provider you want to use.

This tab lists all OLE DB providers detected on your computer.

A provider is selected by default, depending on your SAP Financial Consolidation database:

If your SAP Financial Consolidation database is SQL, then Microsoft OLE DB Provider for SQL Server is
selected by default.

If your SAP Financial Consolidation database is Oracle, then Microsoft OLE DB Provider for Oracle is
selected by default.

We highly recommend that you use the default provider.

When you click on Next, the Connection tab for the selected OLE DB provider will appear.
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6.2.3 Connection Tab

This tab enables you to enter information specific to the provider selected in the Provider tab. The content of
the tab depends on whether an SQL or Oracle provider was selected.

6.2.4 SQL

This Connection tab is provider-specific and displays only the connection properties required by the OLE DB
provider for Microsoft SQL Server.

If you want to generate an SQL star schema, specify the following information in the Connection tab:

1. The SQL Server name. You can either select a server name from the drop-down menu, or type the path of
the server hosting the database you want to access.
Use the Refresh button to refresh the drop-down menu.
2. Theinformation to connect to the server specified above. You can either use your Windows NT
authentication information or the server authentication information.
o Use Windows NT Integrated security. Select this option to specify that the provider will request a
secure (or trusted) connection to an SQL Server running on Microsoft Windows NT. When selected,
SQL Server uses integrated login security to establish connections using this data source, regardless
of the current login security mode at the server level. Any login ID or password entered will be ignored.
The SQL Server system administrator must have associated your Microsoft Windows network ID with
an SQL Server login ID.
o Use a specific user name and password. Select this option to enter a user name and password to
connect to the data source.
o User name. Enter the user ID used for authentication when you log on to the data source.
o Password. Enter the password used for authentication when you log on to the data source.
o Blank password. This option enables the specified provider to return a blank password in the
connection string.
o Allow saving password. This option enables the password to be saved with the connection string. This
option must be selected.
3. The database. You can either select a database from the drop-down menu listing all of the databases
stored on the server specified above, or type the name of the database you want to access.
o Test Connection. Click on this button to test your connection to the specified data source. If the
connection fails, ensure that the settings are correct. For example, you should recheck all spelling and
case sensitivity.

6.2.5 Oracle

This Connection tab is provider-specific and displays only the connection properties required by the Microsoft
OLE DB provider for Oracle.

If you want to generate an Oracle star schema, specify the following information in the Connection tab:

1. Server name. Enter the Oracle net service name, also known as the TNS alias.
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2. Theinformation to connect to the server specified above.
o User name. Enter the user ID used for authentication when you log on to the data source.
o Password. Enter the password used for authentication when you log on to the data source.
o Blank password. This option enables the specified provider to return a blank password in the
connection string.
o Allow saving password. This option enables the password to be saved with the connection string. This
option must be selected.

o Test Connection. Click on this button to test your connection to the specified data source. If the
connection fails, ensure that the settings are correct. For example, you should recheck all spelling and
case sensitivity.

6.2.6 Advanced and All tabs

These two tabs display the information specified in the Provider and Connection tabs.

You should not use these tabs other than for viewing the specified properties.

6.3 Prefix Name for Tables

You can enter a prefix that will be added to each table name.

Adding a prefix is strongly recommended to avoid overwriting tables if you create several star schemas within
the same database.

The default prefix is the name of the deployment.

6.4 Several Fact Table Definition (Partitions)

When deploying a star schema, only one fact table is created by default. The fact table contains all of the data.

You can create several tables based on specific Data entry periods. These tables are known as "partitions". A
partition corresponds to one table created for the data related to one or more Data entry periods. This means
that one partition can contain one or more Data entry periods.

You can drag and drop Data entry periods into the right pane of the window.

i Note

You can drag and drop all Data entry periods except for one that must remain in the Default column. The
table for this Data entry period is then considered the "default table".

You can decide how you want to name the fact tables you are creating. You can define:
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e Abase name. This is the main name common to all of the fact tables. Each new partition is assigned the
base name and incremented, e.g. "Partition2".
e A suffix to be added to all fact table names.

The fact tables will be named using the following syntax:
[Prefix (applied to all tables)]_[Partition name]_ [Suffix]
The default fact table will be named using the following syntax:

[Prefix (applied to all tables)]_Default_ [Suffix]

i Note

Fact table names are limited to 30 characters.

"co" (for "consolidation") or "pk" (for "package") are automatically added just before the suffix.

6.4.1 Creating Partitions

Procedure

1. Inthe Partition Base Name field, enter the name common to all of the partitions.

2. Drag and drop Data entry periods corresponding to the partitions you want to create from the Default
column into the right pane.
One column is created for each partition and assigned the base name entered in the Partition Base Name
field followed by an incremental number.

i Note

You can add one or more Data entry periods to one partition.

3. If you do not want a specific partition to be named using the base name, right-click on the partition header
and select Rename Partition.

4. Enter the name you want in the field that appears and press the Enter key.

6.4.2 Removing partitions

Procedure

1. Toremove all of the partitions, click on Remove Fact Table Partitions.

2. Toremove a specific partition, drag and drop it into the Default column.
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6.5 Star Schema Issue Resolution

Before deploying a star schema, you need to resolve the issues that are listed in the Issues To Resolve tab. The
tab only appears if there are issues and once you have resolved the issues, the tab no longer appears.

In the tab, you can double-click a row indicating an issue. The location where you must correct the issue is
automatically displayed.

6.6 Star Schema Deployment

Deploying a star schema consists of creating the star schema structure and data by generating all required
tables.

Before deploying a star schema, the Deployment tab enables you to view all of the information that will be taken
into account in the star schema tables. This tab displays:

e All of the dimensions defined in the view.

e All SAP Financial Consolidation consolidations or packages selected (depending on the data level of the
view).

In the Actions column:

e |f nothing is displayed for a specific dimension or member row, this means that the dimension or member
was excluded or had never been included in the view and therefore will not be exported.

® The following information may appear:

o Add: if the corresponding dimension or member was excluded in the last deployment but is now being
included.

o Update: if the corresponding dimension or member was included in the last deployment and is again
being included.

o Remove: if the corresponding dimension or member was included in the last deployment but is now
being excluded.

While deploying a star schema, you can monitor the process using the log displayed in the bottom pane of the
window.

If this pane is not displayed, select [ View » Deployment Log 3.
You can perform the following actions in the log:

e Display or hide one or more types of information by clicking on the Errors, Warnings and/or Messages
buttons.

o Errors: Errors cause the deployment to fail.
o Warnings: Warnings are displayed but do not prevent you from deploying the star schema successfully.
o Messages: Messages indicate each step of the deployment.

e Delete the log by clicking on Clear List.

e Export the log in .csv format by clicking on Export List.
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i Note

Before deploying a star schema, you need to resolve existing issues. If some issues remain unresolved, the
Issues to Resolve tab will remain and the Deploy button will not be accessible.

You can also deploy a star schema without using cube designer interface.

Related Information

Deploy, Re-Process and Update Actions [page 117]

6.6.1 Deploying a Star Schema

Procedure

In the Deployment tab, click on Deploy.

i Note

The date of the deployment will appear in the Last Deployed On field of the General tab.

6.7 Using iAnalysis Reports

If you previously used iAnalysis reports, you can still continue to do so with cube designer.

You should ensure that the star schema tables have the same name and structure as the iAnalysis star schema
tables using the iAnalysisStarSchemaTableNames parameter.

The iAnalysisStarSchemaTableNames parameter is specified in the

Cartesis.InformationDelivery Workbench.exe.config file stored in the cube designer installation folder. Its
default value is "iAnalysisStarSchemaTableNames" value="false". To be able to use your iAnalysis reports, you
should replace "false" with "true".

i Note

If you are a former iAnalysis user, please also refer to the Aggregating members when excluding a
dimension section.
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Related Information

Member Aggregation when Excluding a Dimension [page 115]

6.8 Member Aggregation when Excluding a Dimension

If you exclude a specific dimension in a view, the dimension will not be exported to star schema tables. This
may lead to one member being displayed several times with detailed amounts. If you want the amounts to be
aggregated for each member, you should specify the "StarSchemaAggregation" parameter.

The "StarSchemaAggregation" parameter is specified in the
Cartesis.InformationDelivery.Workbench.exe.config file stored in the cube designer installation folder. Its
default value is "StarSchemaAggregation" value="false".

i Note

For former iAnalysis users, it is recommended that you leave the value of "StarSchemaAggregation" as
"false" if you set the "iAnalysisStarSchemaTableNames" value to "true" (see paragraph above).

The following example illustrates this:

Assuming that you have a SAP Financial Consolidation database with two dimensions and a fact table:

Accounts Units
Al Ul
A2 uz2
A3 U3

U4
Accounts Units Amounts
Al Ul 10
A2 Ul 5
A3 Ul 20
Al u2 6
A2 U2 7

You generate a star schema from the database above and also exclude the Account dimension. Depending on
the value of the "StarSchemaAggregation" parameter, there can be 2 outcomes:

e [fthe "StarSchemaAggregation" parameter is set to "false", the star schema fact table will look like this:
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Units Amounts

Ul 10
Ul 5
Ul 20
uz2 6
uz2 7

e |fthe "StarSchemaAggregation" parameter is set to "true", the star schema fact table will look like this:

Units Amounts
Ul 35
u2 13

Rows with identical dimension definitions will be aggregated.

i Note

If rows are aggregated, then any existing SAP Financial Consolidation cell comments will disappear, as they
cannot be aggregated.
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7 Batches

71 Introduction to Batches

Three exe files enable you to perform the following actions without using the cube designer interface:

e Deploy an SSAS cube, an SAP NetWeaver Business Warehouse (SAP NetWeaver BW) cube or a star
schema; process an SSAS cube or an SAP NetWeaver BW cube; update an SSAS cube (AnalyticsBatch).

e Export solutions (Export).
® |mport solutions (Import).

The three files (AnalyticsBatch, Export and Import) are installed along with cube designer in the installation
directory. Therefore, the command lines must be entered from the installation directory.

A Caution

You must not move the files from the installation directory.

In the paragraphs below, you will be provided with the correct syntax for entering the MS-DOS command lines.

i Note

The command lines contain attributes in order that this command line was more robust and besides, it
allows to type the different parameters in any wished order.

7.2 Deploy, Re-Process and Update Actions

The AnalyticsBatch.exe file enables you to:

® Deploy an SSAS cube or an SAP NetWeaver Business Warehouse (SAP NetWeaver BW) cube.

® Re-process speficic parts of an SSAS cube or an SAP NetWeaver Business Warehouse (SAP NetWeaver
BW) cube.

e Update a cube (for SSAS only).

e |nitialize a cube (for SAP NetWeaver BW only).

® Deploy a star schema.

You must modify the default Deployer URL inthe AnalyticsBatch.config file just like you must doitin the
Cartesis.InformationDelivery.Workbench.exe.config file, whichislocated inthe cube designer
installation directory. To find out more about how to proceed, please refer to the SAP Financial Consolidation
Administration guide.

To run the AnalyticsBatch™ in command line mode, use the following syntax:
ANALYTICSBATCH "/DS:AnalyticsConnectionName"

"/S:
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solution_name" "/V:view name"

" /D:deployment_name" ["/U:user_login" " /P
user_password" " /A authentication_type "]

"/T:task_type"

where:

e /DS : Name of the connection
e /s :Name of the solution

e /v:Name of the view

e /D:Name of the deployment

e /U, /pand /A :SAP Financial Consolidation user name, password and authentication type. They are also

the one used to connect to cube designer.

® /T:i<task type>isdfor deployment, i forinitializing an SAP NetWeaver BW cube, p for re-processing, r
for re-processing selected parts of a cube, £ for updating SSAS cube calculations/named sets.

Example: You can enter the following in the MS-DOS window

ANALYTICSBATCH "/DS:Finance" "/S:Solutionl" "/V:Viewl"

"/D:Deploymentl”™ "/U:ADMIN" "/P:123456" "/A:Enterprise" "/T:d"

Example: Re-process parts of a cube

You can use /T:R to re-process specific parts of the cube. You must enter the cube parts (using their
Deployment Name) between two ' characters and separate the parts with the - character.

/T:R:'A - 2001.12 - VALUECORP - IFRS - EUR',

UsSD'

Related Information

AnalyticsBatch Messages [page 118]
Deployer Messages [page 121]
Help [page 123]

7.2.1 AnalyticsBatch Messages

® [nformation message
e [Error messages
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Related Information

AnalyticsBatch Information Messages [page 119]

AnalyticsBatch Error Messages [page 119]

72.1.1

AnalyticsBatch Information Messages

The information message that comes from the AnalyticsBatch when the deployment or processing is
completed successfully is written to the MS-DOS window and the event log:

Deployment completed:

72.1.2

=, Syntax

The command has been executed successfully

AnalyticsBatch Error Messages

Error messages that come from the AnalyticsBatch are prefixed by “Invalid command : " (apart from the
last one for solution save) and they are written to the MS-DOS window and the event log.

Description

Reason

Timing

Example

Invalid Argument

The user has entered an inva-
lid parameter (e.g. /Data-
Source: instead of /DS:)

Occurs in Command Line De-
signer, during parameter vali-
dation that is executed first.

Invalid command : Invalid

'/DS' parameter not recog-

nised

Missing Arguments

The user has entered less pa-
rameters than the ones re-
quired.

Occurs in Command Line De-
signer, during parameter vali-
dation that is executed first.

Invalid command : missing
setting(s):"/S", "/T"

Cannot find DataSource in
broker machine

Invalid datasource name
passed via /DS argument.

Occurs in Command Line De-
signer, after parameter vali-
dation and before solution re-
trieval from 'id_solutions70'
table.

Invalid command: Cannot
find '"MagiskESParis' data-
source in '"CUKLPTSPY'
broker machine

Cannot find solution

Command line parameter for
deployment (/S) is used to
get the solution from the
'id_solutions70" table in the
SAP Financial Consolidation
database.

Command line parameter for
deployment (/S) is used to
get the solution from the
'id_solutions70' table in the
SAP Financial Consolidation
database.

Invalid command : Cannot
find 'Solutionl' solution
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Description

Reason

Timing

Example

Solution retrieval failed

After getting the solution
data from the 'id_solu-
tions70' table, cube designer
rebuilds the object model
from the XML encoding and
then use this to re-initialise
the Solution object.

This process of solution re-
trieval consists of XML han-
dling and SAP Financial Con-

solidation authentication and

authorisation.

If an error occurs during the
XML handling, an "unknown
failure" error is produced.

Occurs in Command Line De-
signer, after solution retrieval
from 'id_solutions70' table
and before command line
task execution .

Invalid command : Retrieval
of 'Solutionl' solution failed :
Impossible to connect to the
Database : the Data Source
cannot be retrieved.

Solution retrieval failed

If an error occurs during
BusinessObjects Enterprise
logon and rights check, a rel-
evant error is produced.

® |nvalid command : Re-
trieval of 'DefaultSolu-
tion' solution failed :
Could not open the solu-
tion: SAP Financial Con-
solidation user ID or
password incorrect.

e |nvalid command : Re-
trieval of 'Solutionl' sol-
ution failed : The current
user is not allowed to
use cube designer.

Solution retrieval failed

No answer from the SAP Fi-
nancial Consolidation server.

® |nvalid command : Re-
trieval of 'Solutionl' sol-
ution failed : the SAP Fi-
nancial Consolidation
Application Server has
not been initialized

® |nvalid command: Re-
trieval of 'Solutionl' sol-
ution failed : Impossible
to connect to the Data-
base: the Data Source
has not been initialized.

Cannot find view

The value for the command
line parameter for view (/
V:xxx) is used to get the view
info from the solution.

Occurs in Command Line De-
signer, after building the sol-
ution from XML and logging
into SAP Financial Consolida-
tion and before calling the
web deployment service
method.

Cannot find 'ConsView' view
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Description

Reason

Timing

Example

Cannot find deployment

The value for the command
line parameter for deploy-
ment (/D:xxx) is used to get
the deployment info from the
solution.

Occurs in Command Line De-
signer, after building the sol-
ution from XML and logging
into SAP Financial Consolida-
tion and before calling the
web deployment service
method.

Invalid command : Cannot
find 'Cubl' deployment

Process Star Schema not
available

The value for the command
line parameter for processing
(/T:p) cannot be used with
star schema deployments
(only SSAS cube ones).

Occurs in Command Line De-
signer, after building the sol-
ution from XML and logging
into SAP Financial Consolida-
tion and before calling the
web deployment service
method.

Invalid command : The de-
ployment selected is a star
schema. Process function is
not yet available for star
schema

Task execution failed

SSAS server or Deployer URL
not valid

Occurs before calling the web
service method.

Invalid command : Execution
of command line task failed

Saving solution failure

Error during solution save.

Last task before the com-
mand line execution ends.

Saving solution failure : Ob-
ject reference not set to an
instance of an object.

Update formula function for
Star Schema not available

The command line parame-
ter for updating formula (/
t:f) cannot be used with star
schema nor SAP NetWeaver
BW deployments (only SSAS
cube ones).

Occurs in Command Line De-
signer, after building the sol-
ution from XML and logging
into SAP Financial Consolida-
tion and before calling the
web deployment service
method.

Invalid command : The de-
ployment selected is a star
schema. Update formula
function is not yet available
for star schema.

7.2.2 Deployer Messages

e |nformation message
® [Error messages

Related Information

Cube Deployer Information Message [page 121]

Cube Deployer error messages [page 122]

72.2.1

Cube Deployer Information Message

Information messages that come from the Cube Deployer™ web service (the errors, warning and messages that
are displayed in the Deployment Log of cube designer when in GUI mode) are stored in the technical log under
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the Deployer.Deployment category only if you add the categorySources section with the following text of the
web.config file:

<add switchValue="All" name="Deployer.Deployment">
<listeners>

<add name="FlatFile TracelListener" />
</listeners>

</add>

To find out more about the technical log, please refer to the SAP Financial Consolidation Administration guide.

7.2.2.2 Cube Deployer error messages

‘=, Syntax

Error messages that come from the Cube Deployer” web service are prefixed by “Deployment failure : " or
“Processing failure : ”. They are written to the MS-DOS window, the event log and the technical log (apart
from the first one) as specified in web.config under the Deployer.Deployment category (no need to add
anything to the categorySources section since errors are always recorded).

In the MS-DOS window, these are:

Description Reason Timing Example
Deployment Service not The processing/deployment ~ Occurs when trying to call Processing failure : Deploy-
found task cannot be executed be-  the web service method for ~ ment service not found

cause the web service isnot  the task.
running and cannot be

started.
Operation failure Error during Deployer web Occurs during the execution  Deployment failure : Process-
service operation. of the Deployer web service  ing of dimension 'Period’
operation. failed. Data not copied into
Star Schema table 'Starl_Pe-
riod'.

Incorrect syntax near the
keyword 'INTO".

Cannot deploy star schema
for deployment 'DefaultStar-
SchemaDeployment' with
'Starl' table prefix
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7.2.3 Help

When the user enters AnalyticsBatch /H, the following syntax is displayed on the MS-DOS window, telling
you what you should enter to perform a deployment:

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube
Designer>AnalyticsBatch "/H

AnalyticsBatch - Performs Cube Designer deployments of star schema and SSAS and
BW cubes.

Syntax:

ANALYTICSBATCH "/DS:datasourcename" "/S:solution name" "/V:view name" "/
D:deployment name"

"/A:authentication type" "/U: user loggin" "/P _user password" "/T:task type"
where:

<TaskType> is d for deployment, i for initializing an SAP NetWeaver BW cube, p
for re-processing,

r for re-processing selected parts of a cube, and f for updating SSAS cube
calculations/name sets

7.3 Solution Export

The export exe file enables you to export solutions into an XML file.
The path for the different xml files must be specified into the command line.

You can omit /P since SAP Financial Consolidation allows blank passwords.

Example: Command line for this program

EXPORT /DS :dataSourceName
[ /U:username /P:password /A:authentication ]

/F: XML File name
solution #1 [solution #2]1 ... [solution #N]

Example: Path for the xml files

solutions.xml, c:\directory\solutions.xmland ../xml/solutions.xml
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7.3.1 Confirmation Message

The confirmation message appears as follows:

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube Designer>export
/DS:Magisk /U:ADMIN /P:123456 /A:Windows /F:testtwo.xml "ID Solution" Basic
Solution export started for 2 solutions.

Opening solution 'ID Solution' (1 of 2).

Exporting solution 'ID Solution'.

Opening solution 'Basic' (2 of 2).

Exporting solution 'Basic'.

7.3.2 Error Messages

Wrong data source:

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube Designer\
EXPORT"/DS:WRONG" "/U:ADMIN" "/P:" "/A:Windows" "/F:Batch_Export.xml" "VAL-PYBO"
"VAL-PYBO1" "VAL-IDEV"

Invalid command : Cannot find 'WRONG' datasource in 'st-srv10' broker machine
C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube Designer>pause
Press any key to continue

Wrong User and/or Password:

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube Designer\
>EXPORT "/DS:LVisQL20057ES" "/U:WRONG" "/P:" "/A:Windows" "/F:BatchiExport.xml"
"VAL-PYBO" "VAL-PYBO1l" "VAL-IDEV"

Solution export started for 3 solutions.

Opening solution 'VAL-PYBO' (1 of 3).

Could not open the solution: BusinessObjects Enterprise user id or password
incorrect.

Opening solution 'VAL-PYBOl' (2 of 3).

Could not open the solution: BusinessObjects Enterprise user id or password
incorrect.

Opening solution 'VAL-IDEV' (3 of 3).

Could not open the solution: BusinessObjects Enterprise user id or password
incorrect.

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube Designer>pause
Press any key to continue

For other messages such as 'invalid path' and 'unrecognized parameter', please refer to the Batch deployment
error messages section.

74 Solution Import

The import exe file enables you to import solutions from an XML file into cube designer.

A /OVERWRITE flag has been added that causes imported solutions to overwrite solutions with the same name.
If this flag is omitted the solutions will be renamed as SOLUTION_1, SOLUTION_2, etc. just like the GUI
versions.
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The path for the different xml files must be specified into the command line.

You can omit /P since SAP Financial Consolidation allows blank passwords.

Example: Command line for this program

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube Designer>import

IMPORT - Imports solutions from an external XML file.

IMPORT "/DS:datasourcename" ["/U:user loggin" "/P:user password" "/
A:authentication type"] "/F:xml solution import file path and name" [/OVERWRITE]

Example: Path for the xml files

solutions.xml, c:\directory\solutions.xml and ../xml/solutions.xml

7.4.1 Confirmation Message

Examples of a typical confirmation message

Example

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube
Designer>import /DS:Magisk /U:ADMIN /P:123456 /A:Windows

/F:testone.xml

Started import of solutions in file testone.xml.

Found 1 solutions.

Importing solution 'ID Solution' (1 of 1).

Import ok, saving solution as 'ID Solution 3'.

The solution 'ID Solution 3' was successfully saved to the data source 'Magisk'.

Example

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube
Designer>import /DS:Magisk /U:ADMIN /P:123456 /A:Windows
/F:testtwo.xml /OVERWRITE

Started import of solutions in file testtwo.xml.

Found 2 solutions.

Importing solution 'ID Solution' (1 of 2).

Import ok, saving solution as 'ID Solution'.
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The solution 'ID Solution' was successfully saved to the data source 'Magisk'.
Importing solution 'Basic' (2 of 2).

Import ok, saving solution as 'Basic'.

The solution 'Basic' was successfully saved to the data source 'Magisk'.

7.4.2 Error Messages

Wrong data source:

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube
Designer>IMPORT "/DS:WRONG" "/U:ADMIN" "/P: "/A:Windows" /F:Batch Export.xml"
"VAL-PYBO" "VAL-PYBO1l" "VAL-IDEV"

Invalid command : Cannot find 'WRONG' datasource in 'st-srv10' broker machine
C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube Designer>pause
Press any key to continue

Wrong user and/or password:

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube
Designer>IMPORT "/DS:LV_SQL2005_ES" "/U:WRONG" "/P:" "/A:Windows" "/

F:Batch Export.xml" "/OVERWRITE"

Started import of solutions in file Batch Export.xml.

Found 2 solutions.

Importing solution 'VAL-PYBO1l' (1 of 2).

Import failed [Reason='Error connecting to magnitude
(MagnitudeCredentialsFailed) '].

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube Designer>pause
Press any key to continue

Wrong file path:

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube
Designer>IMPORT "/DS:LV_SQL2005 ES" "/U:ADMIN" "/P:" "/A:Windows" "/F:WRONG.xml"
"/OVERWRITE"

Started import of solutions in file WRONG.xml.

Import failed [Reason='Expected to find WRONG.xml'].

C:\Program Files\SAP BusinessObjects\Financial Consolidation\Cube Designer>pause
Press any key to continue
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8 About the Application

You can consult information about the application by selecting ||» Help » About SAP Financial Consolidation,

cube designer . The screen that opens states the SAP Financial Consolidation, cube designer version and
copyright.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.

e Links with the icon &: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

SAP Financial Consolidation Cube Designer User Guide
128 PUBLIC Important Disclaimers and Legal Information



SAP Financial Consolidation Cube Designer User Guide
Important Disclaimers and Legal Information PUBLIC 129



/contactsap

© 2020 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form
or for any purpose without the express permission of SAP SE or an SAP
affiliate company. The information contained herein may be changed
without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software vendors.
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any
kind, and SAP or its affiliated companies shall not be liable for errors or
omissions with respect to the materials. The only warranties for SAP or
SAP affiliate company products and services are those that are set forth
in the express warranty statements accompanying such products and
services, if any. Nothing herein should be construed as constituting an
additional warranty.

SAP and other SAP products and services mentioned herein as well as
their respective logos are trademarks or registered trademarks of SAP
SE (or an SAP affiliate company) in Germany and other countries. All
other product and service names mentioned are the trademarks of their
respective companies.

Please see https://www.sap.com/about/legal/trademark.html for
additional trademark information and notices.

THE BEST RUN


https://www.sap.com/about/legal/trademark.html

	SAP Financial Consolidation Cube Designer User Guide
	Content
	1 What's New in Cube Designer
	2 Getting Started
	2.1 General Overview of Cube Designer
	2.2 Connecting to Cube Designer
	2.3 Main Steps
	2.4 Cube Designer Functional Rights
	2.5 Overview of Reporting in SAP HANA
	2.6 Displaying your Personal Information

	3 Solutions
	3.1 Introduction to Solutions
	3.2 Creating Solutions
	3.3 Opening Solutions
	3.4 Renaming Solutions
	3.5 Delete Solutions
	3.5.1 Deleting Solutions

	3.6 Language Selection
	3.7 Solution Export and Import
	3.7.1 Exporting Solutions
	3.7.2 Importing Solutions


	4 Views
	4.1 Introduction to views
	4.2 View Creation
	4.2.1 Scope Hierarchies Historization
	4.2.2 Creating Views

	4.3 Language Selection
	4.3.1 Choosing the languages for the cube

	4.4 Measure Selection and Definition
	4.4.1 Multi- or Single Measure Modes
	4.4.2 Multi-measures Behavior
	4.4.2.1 Activating the Multi-measures Mode
	4.4.2.2 Selecting a Dimensional Analysis
	4.4.2.3 Creating a Dimensional Analysis
	4.4.2.4 Selecting Data Amounts for the Measure Dimension

	4.4.3 Single Measure Behavior
	4.4.3.1 Selecting the Data Amounts (for the Measure dimension) and a Dimensional Analysis


	4.5 Scopes
	4.5.1 Viewing a scope hierarchy

	4.6 Merged Dimension Definition
	4.6.1 Merged dimensions
	4.6.1.1 Pre-defined Merges
	4.6.1.1.1 Merging a Pre-defined Combination of Dimensions

	4.6.1.2 Customized Merges
	4.6.1.2.1 Merging the Dimensions of your Choice


	4.6.2 Name Change and Translation for Merged Dimensions
	4.6.2.1 Changing and Translating the Name of a Merged Dimension

	4.6.3 Member Name and Selection for a Merged Dimension
	4.6.3.1 Naming the Members of a Merged Dimension
	4.6.3.2 Selecting the Members of a Merged Dimension
	4.6.3.3 Scope Hierarchies Order
	4.6.3.3.1 Ordering Scope Hierarchies for the Consolidations Merged Dimension



	4.7 Standard Dimensions
	4.7.1 Reporting Category Dimension Creation
	4.7.1.1 Creating the Reporting Category Dimension and its Members

	4.7.2 Name Change and Translation for Standard Dimensions
	4.7.2.1 Choosing a Name for all the Standard Dimensions
	4.7.2.2 Changing the Name of one Standard Dimension

	4.7.3 Member Name for Standard Dimensions
	4.7.3.1 Choosing a Name for all the Members of Standard Dimensions
	4.7.3.2 Changing the Name and Add a Prefix and/or a Suffix to the Name of all the Members for a Standard Dimension
	4.7.3.3 Adding Member Names for all the Members of all Standard Dimensions
	4.7.3.4 Add Member Names for all the Members of a Standard Dimension

	4.7.4 Start and End Date Definition for Periods
	4.7.4.1 Defining the Dates for Periods

	4.7.5 Member Name for the Period and Data Entry Period Dimensions
	4.7.6 Member Selection for Standard Dimensions
	4.7.6.1 Custom Filtering
	4.7.6.2 SAP Financial Consolidation Filtering
	4.7.6.3 Selecting Members for a Standard Dimension

	4.7.7 Hierarchy Selection
	4.7.7.1 Parent Child hierarchies and Data Members
	4.7.7.1.1 Choosing Data Members not to be Created

	4.7.7.2 Aggregation Definition
	4.7.7.3 Automatic Aggregations Enabled on the Period and Data Entry Period Dimension Hierarchies
	4.7.7.3.1 Activating Automatic Time Aggregation

	4.7.7.4 Hierarchy Selection and Definition for the Period and Data Entry Period Dimensions
	4.7.7.5 General Actions on Hierarchies
	4.7.7.5.1 Selecting a Hierarchy
	4.7.7.5.2 Renaming a Hierarchy
	4.7.7.5.3 Translating a Hierarchy
	4.7.7.5.4 Selecting a Default Member for a Hierarchy
	4.7.7.5.5 Setting a Name for the "All" Node of a Hierarchy
	4.7.7.5.6 Sorting Hierarchies
	4.7.7.5.7 Deleting the Leaf Members and Keep only the Nodes of a Hierarchy


	4.7.8 Attribute Selection
	4.7.9 Standard Dimensions Exclusion
	4.7.9.1 Excluding a Standard Dimension

	4.7.10 Hide Excluded Dimensions
	4.7.10.1 Hiding Excluded Dimensions

	4.7.11 Database and Cube Structure Synchronization
	4.7.11.1 Enabling the Dimension Member Synchronization


	4.8 View Copy
	4.8.1 Copying and Pasting a View

	4.9 Renaming a View

	5 Cube Deployments
	5.1 Introduction to Cube Deployments
	5.2 SSAS Cube Deployments
	5.2.1 SSAS Deployment Creation
	5.2.1.1 Creating an SSAS Deployment

	5.2.2 SSAS Deployment and Cube Information
	5.2.3 Database and Cube Data Synchronization
	5.2.3.1 Query Poll Interval
	5.2.3.2 Silence Interval and Silence Override Interval
	5.2.3.3 Rebuild Interval
	5.2.3.4 Activating the Data Synchronization

	5.2.4 Calculated Members
	5.2.4.1 Creating Calculated Members
	5.2.4.2 Importing Calculated Members
	5.2.4.3 Translating Calculated Members

	5.2.5 Using your own MDX Scripts in a Deployment
	5.2.5.1 Linking your Script to a Deployment

	5.2.6 SSAS Named Set Creation based on SAP Financial Consolidation Characteristics and Filters
	5.2.6.1 Creating SSAS Named Sets
	5.2.6.2 Translating SSAS Named Sets

	5.2.7 SSAS Deployment Issue Resolution
	5.2.8 External Data Loading into an SSAS Cube
	5.2.8.1 Dimension Members
	5.2.8.2 Amounts
	5.2.8.3 Server Selection and Server Information Entry
	5.2.8.4 Loading External Data into a Cube

	5.2.9 SSAS Cube Deployment and Processing
	5.2.9.1 Deploying an SSAS Cube
	5.2.9.2 Processing an SSAS Cube
	5.2.9.3 Processing only Parts of an SSAS Cube

	5.2.10 SSAS Deployment Update
	5.2.10.1 Updating an SSAS Deployment

	5.2.11 Remove an SSAS Cube
	5.2.11.1 Removing an SSAS Cube

	5.2.12 Remove an SSAS Database
	5.2.12.1 Removing an SSAS Database


	5.3 SAP NetWeaver Business Warehouse Cube Deployments
	5.3.1 SAP NetWeaver Business Warehouse Deployment Creation
	5.3.1.1 Creating an SAP NetWeaver Business Warehouse Deployment

	5.3.2 SAP NetWeaver Business Warehouse Deployment and Cube Information
	5.3.3 Cube Deployment based on Another Cube for Transport Purposes
	5.3.4 SAP NetWeaver Business Intelligence Deployment Issue Resolution
	5.3.5 External Data Loading into an SAP NetWeaver Business Warehouse Cube
	5.3.5.1 Dimension Members
	5.3.5.2 Amounts
	5.3.5.3 Server Selection and Server Information Entry
	5.3.5.4 Loading External Data into the SAP NetWeaver Business Warehouse Cube

	5.3.6 SAP NetWeaver Business Warehouse Dimensions and Characteristics Organization
	5.3.6.1 Choosing the SAP NetWeaver Business Warehouse Dimensions and Characteristics Organization
	5.3.6.2 Moving an SAP NetWeaver Business Warehouse Characteristic to a Lower or Upper Dimension
	5.3.6.3 Creating an SAP NetWeaver Business Warehouse Dimension
	5.3.6.4 Renaming an SAP NetWeaver Business Warehouse Dimension
	5.3.6.5 Deleting an SAP NetWeaver Business Warehouse Dimension

	5.3.7 SAP NetWeaver Business Warehouse Cube Deployment and Processing
	5.3.7.1 Deploying an SAP NetWeaver Business Warehouse Cube
	5.3.7.2 Processing only Parts of an SAP NetWeaver Business Warehouse Cube

	5.3.8 Deploying only Most Detailed Data in an SAP NetWeaver Business Warehouse Cube
	5.3.9 Initialize a NetWeaver Business Warehouse Deployment
	5.3.10 Remove an SAP NetWeaver Business Warehouse Cube
	5.3.10.1 Removing an SAP NetWeaver Business Warehouse Cube

	5.3.11 Remove an SAP NetWeaver Business Warehouse InfoArea
	5.3.11.1 Removing an InfoArea


	5.4 SAP HANA Deployments
	5.4.1 SAP HANA Deployment
	5.4.2 Creating a SAP HANA Deployment
	5.4.3 Remove the Modeling Views from SAP HANA

	5.5 Deployment Copy
	5.5.1 Copying and Pasting a Deployment

	5.6 Renaming a Deployment
	5.7 Deployments Audit
	5.7.1 Auditing Deployments


	6 Star Schema Deployments
	6.1 Introduction to Star Schemas
	6.2 Star Schema Deployment Creation
	6.2.1 Creating a Star Schema Deployment
	6.2.2 Provider Tab
	6.2.3 Connection Tab
	6.2.4 SQL
	6.2.5 Oracle
	6.2.6 Advanced and All tabs

	6.3 Prefix Name for Tables
	6.4 Several Fact Table Definition (Partitions)
	6.4.1 Creating Partitions
	6.4.2 Removing partitions

	6.5 Star Schema Issue Resolution
	6.6 Star Schema Deployment
	6.6.1 Deploying a Star Schema

	6.7 Using iAnalysis Reports
	6.8 Member Aggregation when Excluding a Dimension

	7 Batches
	7.1 Introduction to Batches
	7.2 Deploy, Re-Process and Update Actions
	7.2.1 AnalyticsBatch Messages
	7.2.1.1 AnalyticsBatch Information Messages
	7.2.1.2 AnalyticsBatch Error Messages

	7.2.2 Deployer Messages
	7.2.2.1 Cube Deployer Information Message
	7.2.2.2 Cube Deployer error messages

	7.2.3 Help

	7.3 Solution Export
	7.3.1 Confirmation Message
	7.3.2 Error Messages

	7.4 Solution Import
	7.4.1 Confirmation Message
	7.4.2 Error Messages


	8 About the Application
	Important Disclaimers and Legal Information
	Copyright / Legal Notice


